Installation and Configuration Guide for Cisco Services Ready Engine Virtualization

Software Release 1.5
June 2011
The Cisco implementation of TCP header compression is an adaptation of a program developed by the University of California, Berkeley (UCB) as part of UCB's public domain version of the UNIX operating system. All rights reserved. Copyright © 1981, Regents of the University of California.

Notwithstanding any other warranty herein, all document files and software of these suppliers are provided "as is" with all faults. Cisco and the above-named suppliers disclaim all warranties, expressed or implied, including, without limitation, those of merchantability, fitness for a particular purpose and noninfringement or arising from a course of dealing, usage, or trade practice.

In no event shall Cisco or its suppliers be liable for any indirect, special, consequential, or incidental damages, including, without limitation, lost profits or loss or damage to data arising out of the use or inability to use this manual, even if Cisco or its suppliers have been advised of the possibility of such damages.

Cisco and the Cisco Logo are trademarks of Cisco Systems, Inc. and/or its affiliates in the U.S. and other countries. A listing of Cisco's trademarks can be found at www.cisco.com/go/trademarks. Third party trademarks mentioned are the property of their respective owners. The use of the word partner does not imply a partnership relationship between Cisco and any other company. (1005R)

Any Internet Protocol (IP) addresses and phone numbers used in this document are not intended to be actual addresses and phone numbers. Any examples, command display output, network topology diagrams, and other figures included in the document are shown for illustrative purposes only. Any use of actual IP addresses or phone numbers in illustrative content is unintentional and coincidental.

Installation and Configuration Guide for Cisco Services Ready Engine Virtualization
© 2011 Cisco Systems, Inc. All rights reserved.
# CONTENTS

**Preface**  
v
**Configuration Quick Reference**  
vii

## CHAPTER 1

**Cisco Services Ready Engine Virtualization Overview**  
1-1

- Cisco SRE-V Overview  
1-1
- Difference Between Cisco SRE-V and VMware vSphere Hypervisor  
1-3
- Hardware Requirements  
1-3
- Software Requirements  
1-4
- Managing Cisco SRE-V  
1-7
- Basic Workflow  
1-7
- Understanding Cisco SRE-V Options and Associated Tasks  
1-8

## CHAPTER 2

**Installing the Cisco SRE Service Module into the Router**  
2-1

- Basic Workflow for Installing the Cisco SRE Service Module into the Router  
2-1
- Verifying the Router, Cisco SRE Service Module, and Cisco IOS Software Version Compatibility  
2-2
- Installing the Cisco SRE Service Module into the Router  
2-2
- Verifying Cisco SRE Service Module Installation  
2-3
- Online Insertion and Removal of the Cisco SRE Service Module  
2-3

## CHAPTER 3

**Configuring the Cisco SRE Service Module Interfaces**  
3-1

- Basic Workflow for Configuring the Cisco SRE Service Module Interfaces  
3-1
- Cisco SRE Service Module Interfaces Overview  
3-2
- Configuring the Cisco SRE Service Module Interfaces  
3-2
  - Prerequisites for Configuring the Cisco SRE Service Module Interfaces  
3-3
  - Configuring the Cisco SRE Service Module Interfaces on the Router  
3-3
    - MGF Layer 2 Switched Configuration—Recommended  
3-4
    - Cisco IOS Layer 3 Routed Configuration Options  
3-11
    - Cisco IOS Layer 3 Routed Configuration—Devices in Different Branch Subnets  
3-11
    - Cisco IOS Layer 3 Routed Configuration—Devices in the Same Branch Subnet  
3-16
  - External Interface Configuration  
3-23
- Reload, Reset, and Shut Down Commands  
3-24
VMware vSphere Hypervisor Does Not Remain in a Shutdown State 6-10
Adding the Virtual Machines in the Same Subnet as the VMware vSphere Hypervisor 6-10

## Chapter 7
Managing RAID 7-1
- Entering the RAID Management Command Environment 7-1
- Hot-Swapping the Faulty RAID 1 Disk Drive 7-3
- Determining the Location of the Physical SATA Drive 7-4
- Commands for Managing RAID 7-4
- Troubleshooting RAID 7-8
  - Cannot View Datastores 7-8
  - Rebuild Process Does Not Start 7-9

## Chapter 8
Recovering from Device or Software Failure 8-1
- Transferring Licenses from a Defective Device to an RMA Device 8-1
- Recovering from a Microsoft Windows Software Failure 8-3

INDEX
Preface

This preface describes the audience and conventions of the *Installation and Configuration Guide for Cisco Services Ready Engine Virtualization 1.5*. It also describes the available product documentation and provides information on how to obtain documentation and technical assistance.

- **Audience**, page v
- **Conventions**, page v
- **Open Source Software Information**, page vi
- **Related Documentation**, page vi
- **Obtaining Documentation and Submitting a Service Request**, page vi

**Audience**

This guide is intended primarily for network administrators, system administrators, and system integrators.

**Conventions**

This document uses the following conventions:

<table>
<thead>
<tr>
<th>Convention</th>
<th>Item</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>boldface</strong> font</td>
<td>Commands and keywords.</td>
</tr>
<tr>
<td><strong>italic</strong> font</td>
<td>Variables for which you supply values.</td>
</tr>
<tr>
<td>[enclosed in brackets]</td>
<td>Optional command keywords. You do not have to select any options.</td>
</tr>
<tr>
<td>{options enclosed in braces</td>
<td>Required command keyword to be selected from a set of options. You must choose one option.</td>
</tr>
<tr>
<td>vertical bar}</td>
<td></td>
</tr>
<tr>
<td><strong>screen</strong> font</td>
<td>Displayed session and system information.</td>
</tr>
<tr>
<td><strong>boldface screen</strong> font</td>
<td>Information you enter.</td>
</tr>
<tr>
<td><strong>italic screen</strong> font</td>
<td>Variables you enter.</td>
</tr>
<tr>
<td><strong>Option &gt; Network Preferences</strong></td>
<td>Choosing a menu item.</td>
</tr>
</tbody>
</table>
Open Source Software Information

Some components of the software created for Cisco Services Ready Virtualization are provided through open source or commercial licensing. For more information about these components and associated copyright statements, see:


Related Documentation

The following related documentation for Cisco Services Ready Engine Virtualization (Cisco SRE-V) is available on Cisco.com:

- Installation and Configuration Guide for Cisco Services Ready Engine Virtualization 1.5 (this document)
- Release Notes for Cisco Services Ready Engine Virtualization 1.5
- FAQs and Troubleshooting Guide for Cisco Services Ready Engine Virtualization 1.5
- Open Source Used In Cisco Services Ready Engine Virtualization Release:1.5

Obtaining Documentation and Submitting a Service Request

For information on obtaining documentation, submitting a service request, and gathering additional information, see the monthly What’s New in Cisco Product Documentation, which also lists all new and revised Cisco technical documentation, at:


Subscribe to the What’s New in Cisco Product Documentation as a Really Simple Syndication (RSS) feed and set content to be delivered directly to your desktop using a reader application. The RSS feeds are a free service and Cisco currently supports RSS version 2.0.
Use this configuration quick reference document if you are familiar with the Cisco Services Ready Engine (SRE) Service Module and VMware vShpere Hypervisor™, and you only need a list of commands and steps to quickly set up and use Cisco Services Ready Engine Virtualization (Cisco SRE-V). Detailed information about the configuration steps is provided in subsequent chapters.

Use this configuration quick reference document if you purchased a blank Cisco SRE Service Module without the Cisco SRE-V or Microsoft Windows software.

See Figure i-1 for an example of the configuration, and see Figure i-2 for the location of the IP addresses, and then complete the steps that follow.
Figure i-1 shows an example of the configuration.

- The left pane shows an example of the Cisco IOS commands that you configure in the sm 1/0, sm 1/1, and VLAN interfaces.
- The right pane shows where the configuration is applied in Cisco SRE-V.

Note

The IP addresses in the configuration example in Figure i-1 are for reference only and might not be valid.
Figure i-2 shows the location of the IP addresses.

To access the VMware vSphere Hypervisor™ through the ISR G2, you must provide two IP addresses: One IP address is of the interface that connects the router to the VMware vSphere Hypervisor™, and the other IP address is of the VMware vSphere Hypervisor™.

The virtual machines are accessed through the MGF interface. The port groups on a vSwitch in the VMware vSphere Hypervisor™ can be assigned to corresponding VLAN interfaces in Cisco IOS. For example, port group 50 in the VMware vSphere Hypervisor™ can be assigned to VLAN 50 in Cisco IOS.

To set up and configure Cisco SRE-V, complete the following steps:

**Step 1** Install the Cisco SRE Service Module into the router. See Chapter 2, “Installing the Cisco SRE Service Module into the Router.”

**Step 2** Configure the Cisco SRE Service Module interfaces.

- Use the following commands from the host-router CLI:
  - `enable`
  - `configure terminal`
- Configure slot/0 of the VMware vSphere Hypervisor™:
  - `interface sm slot/0`
  - `ip address router-to-hypervisor-interface-IP-address subnet-mask`
  - `service-module ip address hypervisor-ip-address subnet-mask`
  - `service-module ip default-gateway hypervisor-gateway-ip-address`
  - `no shut`
  - `exit`
- Configure slot/1 of the VMware vSphere Hypervisor™:
  - `interface sm slot/1`
  - `switchport mode trunk`
  - `exit`
- Configure VLANs:
  - `configure terminal`
  - `interface vlan vlan_number`
  - `ip address vlan-ip-address subnet mask`
  - `no shut`
  - `end`

- Save the configuration:
  - `copy running-config startup-config`
  - `show running-config`

For details, see Chapter 3, “Configuring the Cisco SRE Service Module Interfaces.”

**Step 3**
Go to [http://www.cisco.com/go/ucse](http://www.cisco.com/go/ucse), click Download Software, and then download the Cisco SRE-V files.

**Step 4**
Install the Cisco SRE-V software. Use the following commands from the host-router CLI:

  a. `enable`
  b. `service-module sm slot0 install url url argument disk-cfg-mode={raid1 | raid0 | nonraid}`

For details, see Chapter 4, “Installing and Managing the Cisco SRE-V Software.”

**Step 5**
Register and activate the VMware vSphere Hypervisor™ license.

For details, see Chapter 5, “Managing the VMware vSphere Hypervisor License.”

**Step 6**
Go to [https://hypervisor-ip-address](https://hypervisor-ip-address), and download the vSphere Client. For details, see Chapter 6, “Managing Virtual Machines.”

**Step 7**
Install the vSphere Client. For details, see Chapter 6, “Managing Virtual Machines.”

**Step 8**
Install your own version of the Microsoft Windows Server 2003 software, Microsoft Windows Server 2008 software, or Linux distribution, and then activate the software license.

**Note**
Microsoft Windows Server software is not available for download from Cisco.com. It can only be purchased together with the service module.

**Step 9**
Configure the IP addresses for the Microsoft Windows Server by using the standard Microsoft Windows network configuration setup process. See the Microsoft Windows virtual machines in Figure i-1 for an example of the network settings.

**Step 10**
Install VMware tools. For details, see the “Installing VMware Tools” section on page 6.
Cisco Services Ready Engine Virtualization Overview

Last Updated: August 4, 2011

This chapter provides an overview of the Cisco Services Ready Engine Virtualization (Cisco SRE-V) product. It includes information about the hardware and software requirements, feature licenses, and tasks that you must complete to set up Cisco SRE-V.

This chapter contains the following sections:

- Cisco SRE-V Overview, page 1-1
- Difference Between Cisco SRE-V and VMware vSphere Hypervisor, page 1-3
- Hardware Requirements, page 1-3
- Software Requirements, page 1-4
- Managing Cisco SRE-V, page 1-7
- Basic Workflow, page 1-7
- Understanding Cisco SRE-V Options and Associated Tasks, page 1-8

Cisco SRE-V Overview

Cisco SRE-V is a branch-office infrastructure platform that combines computing, networking, storage access, virtualization, and unified management into a cohesive system. It enables the VMware vSphere Hypervisor™ to be provisioned on a Cisco Services Ready Engine (SRE) Service Module and host one or multiple virtual machines running the Microsoft Windows Server or Linux operating systems. The entire system is integrated with the Generation 2 of the Cisco Integrated Services Router (ISR G2).
Figure 1-1 provides an example of a Cisco SRE-V system deployment.

**Figure 1-1 Example of a Cisco SRE-V System Deployment**

<p>| | | | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Client Devices</td>
<td>4</td>
<td>Virtual Machines Hosted on Cisco SRE-V</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Cisco SRE-V Management Console</td>
<td>5</td>
<td>Enterprise Storage Device</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>Cisco ISR G2 Router with Cisco SRE Service Module and Cisco SRE-V</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Cisco SRE-V Terms**

The following Cisco SRE-V terms are used in this guide:

- **Cisco SRE Service Module**—Intel x86 architecture blade server that is hosted in a Cisco ISR G2. The Cisco SRE Service module provides the dedicated processing, network, storage, and memory to run the VMware vSphere Hypervisor™.

- **VMware vSphere Hypervisor™**—Bare-metal hypervisor from VMware that provides the platform to host virtual machines.

- **Virtual Machines**—User-created virtual machines that run the Microsoft Windows Server or Linux operating systems.

See Figure 1-2 to understand the Cisco SRE-V terms.

**Figure 1-2 Cisco SRE-V Terms**

- Linux Virtual Machines
- Microsoft Windows Virtual Machines
- VMware vSphere Hypervisor
- Cisco SRE Service Module
Difference Between Cisco SRE-V and VMware vSphere Hypervisor

The Cisco SRE-V product is different from the VMware vSphere Hypervisor™ in the following ways:

• Cisco SRE-V enables VMware vSphere Hypervisor™ to be provisioned on a Cisco SRE Service Module, which is integrated in the Cisco ISR G2.

• Configuration of the VMware vSphere Hypervisor™ IP address is done through the Cisco ISR G2.

• Redundant Array of Inexpensive Disks (RAID) management for Cisco SRE-V is done through the RAID management CLI.

• Software upgrade packages are obtained from Cisco.com.

• PCI Passthrough settings are not applicable for the current generation hardware.

Hardware Requirements

The Cisco SRE-V software runs on the Cisco SRE Service Module, which is the hardware component of Cisco SRE-V. The Cisco SRE Service Module can reside either in the Cisco 2900 series or 3900 series ISR G2.

The Cisco SRE-V software is supported on the following service modules:

• Cisco SRE 700 Service Module
• Cisco SRE 900 Service Module

Table 1-1 provides the hardware information for each of the supported service modules.

<table>
<thead>
<tr>
<th>Feature</th>
<th>Cisco SRE 700 Service Module</th>
<th>Cisco SRE 900 Service Module</th>
</tr>
</thead>
<tbody>
<tr>
<td>Form Factor</td>
<td>SM</td>
<td>SM</td>
</tr>
<tr>
<td>CPU</td>
<td>Intel Core 2 Solo (one core active), 1.86 GHz</td>
<td>Intel Core 2 Duo (two cores active), two 1.86 GHz</td>
</tr>
<tr>
<td>DRAM</td>
<td>4 GB</td>
<td>4 GB or 8 GB</td>
</tr>
<tr>
<td>eUSB Flash Memory</td>
<td>2-GB internal USB flash-memory module</td>
<td>2-GB internal USB flash-memory module</td>
</tr>
<tr>
<td>Hard Disk</td>
<td>1 x 500 GB</td>
<td>2 x 500 GB (1 TB)</td>
</tr>
</tbody>
</table>
| Internal Network Interfaces | 1 Layer 2 Gigabit Ethernet interface  
1 Layer 3 Gigabit Ethernet interface | 1 Layer 2 Gigabit Ethernet interface  
1 Layer 3 Gigabit Ethernet interface |
| External Network Interfaces | 1 USB connector  
1 RJ-45 Gigabit Ethernet connector | 1 USB connector  
1 RJ-45 Gigabit Ethernet connector |
| Router Platforms         | 2911, 2921, 2951, 3925, 3925e, 3945, 3945e           | 2911, 2921, 2951, 3925, 3925e, 3945, 3945e           |
Table 1-2 shows the Cisco EtherSwitch Enhanced High-Speed WAN Interface Cards (EHWICs) and Cisco EtherSwitch service modules that are supported on the Cisco ISR G2.

<table>
<thead>
<tr>
<th>Cisco EtherSwitch EHWIC</th>
<th>Cisco EtherSwitch Service Module</th>
</tr>
</thead>
</table>

Software Requirements

This section provides information about third-party software, Cisco SRE-V options, and feature licenses.

Third-Party Software

Cisco SRE-V uses the following third-party software:

- VMware vSphere Hypervisor™—For virtualization.
- Microsoft Windows Server—for the guest operating system in virtual machines.

  The following Microsoft Windows Servers are certified:
  - Windows Server 2003 SP2 Standard 32-bit and 64-bit
  - Windows Server 2003 SP2 Enterprise 32-bit and 64-bit
  - Windows Server 2008 R2 Standard 64-bit
  - Windows Server 2008 R2 Enterprise 64-bit
- Linux—for the guest operating system in virtual machines.

For a list of supported Linux distributions, see the VMware Compatibility Guide at: http://www.vmware.com/resources/compatibility/search.php?deviceCategory=software

Cisco SRE-V Options

Cisco SRE-V is available in the following three options:

- Hardware only (Cisco SRE 700 or 900 Service Module)—Cisco SRE Service Module without any software installed on it. See Option 1 in Figure 1-3.

  If you purchase this option, you must do the following:
  - Download and install the Cisco SRE-V software.
  - Download and install your own version of the Microsoft Windows Server 2003 software, Microsoft Windows Server 2008 software, or Linux distribution.
  - Purchase a “spare” VMware vSphere Hypervisor license from Cisco.com, otherwise the Cisco SRE-V software will stop functioning after the 60 day evaluation period expires. After you purchase the license, you must register and activate it.

For more information about VMware vSphere Hypervisor licenses, see Chapter 5, “Managing the VMware vSphere Hypervisor License.”
Chapter 1  Cisco Services Ready Engine Virtualization Overview

Software Requirements

- **Hardware plus Virtualization software (Cisco SRE 700 or 900 Service Module + Cisco SRE-V)—Cisco SRE Service Module with Cisco SRE-V software preinstalled. At the time of purchase, you can choose the RAID option that you want enabled on the Cisco SRE-V software. See Option 2 in Figure 1-3.**

  **Note**  RAID is not supported on the Cisco SRE 700 Service Module. It is supported on the Cisco SRE 900 Service Module only.

Purchase this option if you have your own version of Microsoft Windows Server 2003 software, Microsoft Windows Server 2008 software, or Linux distribution that you want to use.

If you purchase this option, you must do the following:

- Download and install your own version of the Microsoft Windows Server 2003 software, Microsoft Windows Server 2008 software, or Linux distribution.

- Activate your VMware vSphere Hypervisor license.

  If you purchase the VMware vSphere Hypervisor license at the same time you purchase the Cisco SRE Service Module, a VMware license key is shipped to you in an envelope. This envelope is in the same package as the Cisco SRE Service Module. To use the Cisco SRE-V software, you must activate the VMware license key using the vSphere Client GUI, otherwise the Cisco SRE-V software will stop functioning after the 60 day evaluation period expires.

  If you choose to purchase the VMware vSphere Hypervisor license after you purchase the Cisco SRE Service Module, you must purchase a “spare” VMware vSphere Hypervisor license from Cisco Systems. After you purchase the license, you must register and activate it, otherwise the Cisco SRE-V software will stop functioning after the 60 day evaluation period expires.

  For more information about VMware vSphere Hypervisor licenses, see Chapter 5, “Managing the VMware vSphere Hypervisor License.”

- **Hardware, plus Virtualization software, plus Microsoft Windows software (Cisco SRE 700 or 900 Service Module + Cisco SRE-V + Microsoft Windows Server 2008 R2)—Cisco SRE Service Module with both Cisco SRE-V and Microsoft Windows Server 2008 R2 Standard Edition 64-bit virtual machine preinstalled. At the time of purchase, you can choose the RAID option that you want enabled on the Cisco SRE-V software. See Option 3 in Figure 1-3.**

  **Note**  RAID is not supported on the Cisco SRE 700 Service Module. It is supported on the Cisco SRE 900 Service Module only.

If you purchase this option, you must activate your VMware vSphere Hypervisor license.

If you purchase the VMware vSphere Hypervisor license at the same time you purchase the Cisco SRE Service Module, a VMware license key is shipped to you in an envelope. This envelope is in the same package as the Cisco SRE Service Module. To use the Cisco SRE-V software, you must activate the VMware license key using the vSphere Client GUI, otherwise the Cisco SRE-V software will stop functioning after the 60 day evaluation period expires.

If you choose to purchase the VMware vSphere Hypervisor license after you purchase the Cisco SRE Service Module, you must purchase a “spare” VMware vSphere Hypervisor license from Cisco Systems. After you purchase the license, you must register and activate it, otherwise the Cisco SRE-V software will stop functioning after the 60 day evaluation period expires.

For more information about VMware vSphere Hypervisor licenses, see Chapter 5, “Managing the VMware vSphere Hypervisor License.”
Note With this option, the Microsoft Windows Server 2008 R2 license is preactivated.

Figure 1-3 shows the Cisco SRE-V options.

Figure 1-3 Cisco SRE-V Options

![Cisco SRE-V Options Diagram]

**Feature Licenses**

Table 1-3 provides the feature license Stock-Keeping Units (SKUs) that are available for Cisco SRE-V.

<table>
<thead>
<tr>
<th>License SKUs</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Licenses Without vCenter Support</strong></td>
<td></td>
</tr>
<tr>
<td>FL-SRE-V-HOST</td>
<td>VMware vSphere Hypervisor Host paper license purchased with the software.</td>
</tr>
<tr>
<td>FL-SRE-V-HOST=</td>
<td>VMware vSphere Hypervisor Host paper license purchased without the software (spare).</td>
</tr>
<tr>
<td>L-FL-SRE-V-HOST=</td>
<td>VMware vSphere Hypervisor Host electronic license purchased without the software (spare).</td>
</tr>
<tr>
<td><strong>Licenses With vCenter Support</strong></td>
<td></td>
</tr>
<tr>
<td>FL-SRE-V-HOSTVC</td>
<td>Feature license for the VMware vSphere Hypervisor software on the Cisco SRE Service Module, which includes vCenter management support. This license can be purchased with the software.</td>
</tr>
<tr>
<td>FL-SRE-V-HOSTVC=</td>
<td>Feature license for the VMware vSphere Hypervisor software on the Cisco SRE Service Module, which includes vCenter management support (spare).</td>
</tr>
<tr>
<td>L-FL-SRE-V-HOSTVC=</td>
<td>E-delivery feature license for the VMware vSphere Hypervisor software on the Cisco SRE Service Module, which includes vCenter management support (spare).</td>
</tr>
<tr>
<td><strong>Upgrade Licenses to Add vCenter Support</strong></td>
<td></td>
</tr>
<tr>
<td>FL-SRE-V-VC-UPG=</td>
<td>Feature license to upgrade the VMware vSphere Hypervisor software on the Cisco SRE Service Module to enable vCenter management support (spare).</td>
</tr>
<tr>
<td>L-FL-SRE-V-VC-UPG=</td>
<td>E-delivery feature license to upgrade the VMware vSphere Hypervisor software on the Cisco SRE Service Module to enable vCenter management support (spare).</td>
</tr>
</tbody>
</table>

For more information about VMware vSphere Hypervisor licenses, see Chapter 5, “Managing the VMware vSphere Hypervisor License.”
Managing Cisco SRE-V

Cisco SRE-V uses several management interfaces:

**Cisco IOS CLI**
Use the Cisco IOS CLI to configure the host router and Cisco SRE Service Module interfaces. Cisco SRE-V resides on a Cisco SRE Service Module, which fits into a host Cisco router that runs the Cisco IOS software. For information about the supported Cisco IOS software, see the “Verifying the Router, Cisco SRE Service Module, and Cisco IOS Software Version Compatibility” section on page 2-2.

**RAID Management CLI**
Use the RAID management CLI to add or modify RAID configuration.

**VMware vSphere Client**
Use the VMware vSphere Client to manage virtual machines.

**vCenter Server**
Use the vCenter Server to manage virtual machines.

**Basic Workflow**

1. Install the Cisco SRE Service Module into the ISR G2.
2. Use the Cisco IOS commands to configure the Cisco SRE Service Module interfaces.
3. If you purchased a blank Cisco SRE Service Module, install the Cisco SRE-V software.
4. Register and activate the VMware vSphere Hypervisor™ license.
5. Install the vSphere Client, and then use the vSphere Client GUI to create and manage the virtual machines.
Understanding Cisco SRE-V Options and Associated Tasks

Depending on the Cisco SRE-V software option that you purchase, the tasks that you must perform vary. See Table 1-4.

**Table 1-4  Cisco SRE-V Options and Tasks**

<table>
<thead>
<tr>
<th>Option</th>
<th>If you purchased the SRE Service Module option...</th>
<th>Do the following...</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Hardware only—Cisco SRE Service Module. See Figure 1-3. This option includes a blank Cisco SRE Service Module without the Cisco SRE-V or Microsoft Windows software.</td>
<td>1. Install the Cisco SRE Service Module into the router. See Chapter 2, “Installing the Cisco SRE Service Module into the Router.”&lt;br&gt;2. Configure the Cisco SRE Service Module interfaces. See Chapter 3, “Configuring the Cisco SRE Service Module Interfaces.”&lt;br&gt;3. Download and install the Cisco SRE-V software on the Cisco SRE Service Module. See Chapter 4, “Installing and Managing the Cisco SRE-V Software.”&lt;br&gt;4. Register and activate the VMware vSphere Hypervisor™ license. See Chapter 5, “Managing the VMware vSphere Hypervisor License.”&lt;br&gt;5. Install the vSphere Client to manage the virtual machines. See Chapter 6, “Managing Virtual Machines.”&lt;br&gt;6. Install your own version of the Microsoft Windows Server 2003 software, Microsoft Windows Server 2008 software, or Linux distribution, and then activate the software license. &lt;br&gt;Note: The Microsoft Windows Server software or Linux distribution are not available for download from Cisco.com. The Microsoft Windows Server software can only be purchased together with the service module.&lt;br&gt;7. Install VMware tools. See the “Installing VMware Tools” section on page 6-6.</td>
</tr>
</tbody>
</table>
Table 1-4  Cisco SRE-V Options and Tasks (continued)

<table>
<thead>
<tr>
<th>Option</th>
<th>If you purchased the SRE Service Module option...</th>
<th>Do the following...</th>
</tr>
</thead>
</table>
| 2      | Hardware plus Virtualization software—Cisco SRE Service Module with the Cisco SRE-V software preinstalled. See Figure 1-3. This option does not include the Microsoft Windows Server software or Linux distribution. Purchase this option if you have your own version of Microsoft Windows Server 2003, Microsoft Windows Server 2008, or Linux distribution that you want to use. | 1. Install the Cisco SRE Service Module into the router. See Chapter 2, “Installing the Cisco SRE Service Module into the Router.”
2. Configure the Cisco SRE Service Module interfaces. See Chapter 3, “Configuring the Cisco SRE Service Module Interfaces.”
3. Install the vSphere Client to manage the virtual machines. See Chapter 6, “Managing Virtual Machines.”
4. Activate the VMware license key. See “Activating the VMware License Key” section on page 5-4.
5. Install your own version of the Microsoft Windows Server 2003 software, Microsoft Windows Server 2008 software, or Linux distribution, and then activate the software license.
6. Install VMware tools. See the “Installing VMware Tools” section on page 6-6. |
| 3      | Hardware, plus Virtualization software, plus Microsoft Windows software—Cisco SRE Service Module with both Cisco SRE-V and Microsoft Windows Server 2008 R2 Standard Edition 64-bit virtual machine preinstalled. See Figure 1-3. With this option, you also receive a Microsoft Windows Server 2008 R2 recovery DVD, which you can use if you lose or delete the Microsoft Windows virtual machine from your system. | 1. Install the Cisco SRE Service Module into the router. See Chapter 2, “Installing the Cisco SRE Service Module into the Router.”
2. Use the Cisco IOS commands to configure the Cisco SRE Service Module interfaces. See Chapter 3, “Configuring the Cisco SRE Service Module Interfaces.”
3. Activate the VMware license key. See “Activating the VMware License Key” section on page 5-4.
4. Install the vSphere Client to manage the virtual machines. See Chapter 6, “Managing Virtual Machines.” |
Installing the Cisco SRE Service Module into the Router

Last Updated: August 4, 2011

This chapter provides information about installing the Cisco SRE Service Module into the router. It contains the following sections:

- Basic Workflow for Installing the Cisco SRE Service Module into the Router, page 2-1
- Verifying the Router, Cisco SRE Service Module, and Cisco IOS Software Version Compatibility, page 2-2
- Installing the Cisco SRE Service Module into the Router, page 2-2
- Verifying Cisco SRE Service Module Installation, page 2-3
- Online Insertion and Removal of the Cisco SRE Service Module, page 2-3

Basic Workflow for Installing the Cisco SRE Service Module into the Router

1. Verify that the router, the Cisco SRE Service Module, and the Cisco IOS software version that is installed on the router are compatible. See the “Verifying the Router, Cisco SRE Service Module, and Cisco IOS Software Version Compatibility” section on page 2-2.

2. Install the Cisco SRE Service Module into the router. See the “Installing the Cisco SRE Service Module into the Router” section on page 2-2.

3. Verify that the Cisco SRE Service Module is correctly detected by the router. See the “Verifying Cisco SRE Service Module Installation” section on page 2-3
Verifying the Router, Cisco SRE Service Module, and Cisco IOS Software Version Compatibility

Table 2-1 provides the compatibility between the routers, Cisco SRE Service Modules, and the Cisco IOS software version that you must install on the router to use Cisco SRE-V.

Table 2-1 Cisco Routers, Cisco SRE Service Module, and Cisco IOS Version Compatibility

<table>
<thead>
<tr>
<th>Router</th>
<th>Cisco IOS Software Version for Cisco SRE 700 Service Module</th>
<th>Cisco IOS Software Version for Cisco SRE 900 Service Module</th>
</tr>
</thead>
<tbody>
<tr>
<td>2911</td>
<td>15.1(4)M and later versions</td>
<td>15.1(4)M and later versions</td>
</tr>
<tr>
<td>2921</td>
<td>15.1(4)M and later versions</td>
<td>15.1(4)M and later versions</td>
</tr>
<tr>
<td>2951</td>
<td>15.1(4)M and later versions</td>
<td>15.1(4)M and later versions</td>
</tr>
<tr>
<td>3925</td>
<td>15.1(4)M and later versions</td>
<td>15.1(4)M and later versions</td>
</tr>
<tr>
<td>3925e</td>
<td>15.1(4)M and later versions</td>
<td>15.1(4)M and later versions</td>
</tr>
<tr>
<td>3945</td>
<td>15.1(4)M and later versions</td>
<td>15.1(4)M and later versions</td>
</tr>
<tr>
<td>3945e</td>
<td>15.1(4)M and later versions</td>
<td>15.1(4)M and later versions</td>
</tr>
</tbody>
</table>

Related Topic
- Installing the Cisco SRE Service Module into the Router, page 2-2

Installing the Cisco SRE Service Module into the Router

To install the Cisco SRE Service Module into the Cisco 2900 series or 3900 series ISR G2, see Figure 2-1. For detailed information, see Installing Cisco Network Modules and Service Modules in Cisco Access Routers on Cisco.com.

Figure 2-1 Cisco SRE Service Module in a Router
Caution
Before you install or remove the Cisco SRE Service Module from a Cisco 2900 series ISR G2, make sure that you first power down the router, and then install or remove the Cisco SRE Service Module.

Related Topics
- Verifying Cisco SRE Service Module Installation, page 2-3
- Configuring the Cisco SRE Service Module Interfaces on the Router, page 3-3

Verifying Cisco SRE Service Module Installation

After the Cisco SRE Service Module is physically installed in a Cisco router, and the router is loaded with a compatible Cisco IOS image and powered back on, do the following to ensure that the Cisco SRE Service Module is correctly detected by the router.

To verify the Cisco SRE Service Module installation, complete the following steps:

Step 1 Verify that the router detects the presence of the newly installed Cisco SRE Service Module. From the router, enter enable mode, and then use the `show diag | include FRU` command. The Field Replaceable Unit (FRU) details are displayed, as shown in the following example of a Cisco SRE 900 Service Module:

```
Router# show diag | include FRU
Product (FRU) Number     : CISCO2951/K9
Product (FRU) Number     : PWR-2921-51-POE
Product (FRU) Number     : PVDM3-32
Product (FRU) Number     : SM-SRE-900-K9
```

Step 2 Use the `show hardware` command to verify that the router recognizes the service module.

Related Topics
- Installing the Cisco SRE Service Module into the Router, page 2-2
- Configuring the Cisco SRE Service Module Interfaces on the Router, page 3-3

Online Insertion and Removal of the Cisco SRE Service Module

The Cisco 3900 series ISR G2 supports the Online Insertion and Removal (OIR), or hot swap, of the Cisco SRE Service Module.

The Cisco 2900 series ISR G2 does not support OIR of the Cisco SRE Service Module.

To perform OIR of a Cisco SRE Service Module from a Cisco 3900 series ISR G2, complete the following steps:

SUMMARY STEPS

1. `service-module sm slot/0 shutdown`
2. `service-module sm slot/0 status`
3. `hw-module sm 1 oir-stop`
## DETAILED STEPS

<table>
<thead>
<tr>
<th>Step</th>
<th>Command or Action</th>
<th>Purpose</th>
</tr>
</thead>
</table>
| Step 1 | `service-module sm slot/0 shutdown` | Shuts down the Cisco SRE Service Module system gracefully. Use this command when removing or replacing a hot-swappable module during OIR.  
If the virtual machines on the VMware vSphere Hypervisor™ have VMware tools installed on them, and you issue this command, the virtual machines shut down first, and then the Cisco SRE Service Module shuts down.  
If the virtual machines do not have VMware tools installed on them and you issue this command, the virtual machines power off first, and then the shutdown signal is sent to the service module. After about two minutes, the Cisco SRE Service Module shuts down. |
| **Example:** | `Router# service-module sm 1/0 shutdown` |  |
| Step 2 | `service-module sm slot/0 status` | Verifies whether the Cisco SRE Service Module system is in the shut down state. |
| **Example:** | `Router# service-module sm 1/0 status` |  |
| Step 3 | `hw-module sm 1 oir-stop` | Removes the Cisco SRE Service Module from the router.  
When you enter this command, OIR messages are displayed.  
After the messages finish displaying, remove the Cisco SRE Service Module from the router. |
| **Example:** | `Router# hw-module sm 1 oir-stop` |  |
This chapter provides information about how to configure the Cisco SRE Service Module interfaces to run the Cisco SRE-V System software.

Before you begin, make sure that the ISR G2 in which the Cisco SRE Service Module is installed is running the supported Cisco IOS software version. See the “Verifying the Router, Cisco SRE Service Module, and Cisco IOS Software Version Compatibility” section on page 2-2.

This chapter contains the following sections:

- Basic Workflow for Configuring the Cisco SRE Service Module Interfaces, page 3-1
- Cisco SRE Service Module Interfaces Overview, page 3-2
- Configuring the Cisco SRE Service Module Interfaces, page 3-2
- Reload, Reset, and Shut Down Commands, page 3-24

Basic Workflow for Configuring the Cisco SRE Service Module Interfaces

1. Configure sm1/0 of the VMware vSphere Hypervisor™.
2. Configure sm1/1 of the VMware vSphere Hypervisor™.
3. Configure VLANs.

See the “Configuring the Cisco SRE Service Module Interfaces on the Router” section on page 3-3.
Cisco SRE Service Module Interfaces Overview

The host router and the Cisco SRE Service Module use several interfaces for internal and external communication. Use the Cisco IOS CLI commands to configure each of the interfaces on the router.

Before configuring the interfaces, make sure that you have the following information for entering the Cisco SRE Service Module command environment:

- IP address of the Cisco router that contains the Cisco SRE Service Module.
- Username and password for logging into the router.
- Slot and unit number of the Cisco SRE Service Module.

The Cisco SRE Service Module communicates with the host router through the following three interfaces:

- Console Interface—Console interface allows you to access the VMware vSphere Hypervisor™ Direct Console User Interface (DCUI) to perform Cisco SRE-V configuration. Accessible from within the host router, this interface provides an internal Layer 3 Gigabit Ethernet link between the router and the Cisco SRE Service Module. All configuration and management of the console interface is performed using the Cisco IOS CLI.
- MGF Interface—MGF interface enables the Cisco SRE Service Module to communicate over a high-speed backplane switch. Accessible from within the host router, this interface provides an internal Layer 2 Gigabit Ethernet link between the router and the Cisco SRE Service Module. Configuration of the MGF interface is performed using the Cisco IOS CLI. For more information about configuring MGF, see the “Multi-Gigabit Fabric on the Router” chapter in the Cisco 3900 Series, 2900 Series, and 1900 Series Integrated Services Routers Software Configuration Guide on Cisco.com.
- External Service Module Interface—VMware vSphere Hypervisor™ or virtual machines can use the external service module interface as a primary interface or as a backup interface. Unlike the internal interfaces, the external interface is primarily controlled and managed by the VMware vSphere Hypervisor™. The traffic does not go into the router unless the VMware vSphere Hypervisor™ is configured to forward the traffic into the router through the MGF interface or the console interface.

Related Topic

- Configuring the Cisco SRE Service Module Interfaces, page 3-2

Configuring the Cisco SRE Service Module Interfaces

This section describes how to configure basic network parameters for the Cisco SRE Service Module using the Cisco IOS CLI. It contains the following sections:

- Prerequisites for Configuring the Cisco SRE Service Module Interfaces, page 3-3
- Configuring the Cisco SRE Service Module Interfaces on the Router, page 3-3
Prerequisites for Configuring the Cisco SRE Service Module Interfaces

This section provides the prerequisites for the router and the Cisco SRE Service Module.

Cisco Router Prerequisites

Make sure that your Cisco router is running the appropriate Cisco IOS software version and recognizes the Cisco SRE Service Module. See the “Verifying the Router, Cisco SRE Service Module, and Cisco IOS Software Version Compatibility” section on page 2-2 and the “Verifying Cisco SRE Service Module Installation” section on page 2-3.

Cisco SRE Service Module Prerequisites

In most cases, the routers are shipped with the Cisco SRE Service Module already installed in them.

Identify the Cisco SRE Service Module slot and port location in the host router:

- **slot**—ID of the host router chassis slot in which the Cisco SRE Service Module resides. After you install the service module, you can obtain this information by using the Cisco IOS software CLI `show running-config` command.
- **port**—ID of the Network Interface Card (NIC) on the Cisco SRE Service Module:
  - The value is 0 for the console interface. The console interface allows you to access the VMware vSphere Hypervisor’s DCUI to perform Cisco SRE-V configuration.
  - The value is 1 for the MGF interface. The MGF interface enables the Cisco SRE Service Module to communicate over a high-speed backplane switch.

Related Topics

- Cisco SRE Service Module Interfaces Overview, page 3-2
- Configuring the Cisco SRE Service Module Interfaces on the Router, page 3-3

Configuring the Cisco SRE Service Module Interfaces on the Router

Configure the internal interfaces between the Cisco SRE Service Module and the host router. This initial configuration allows you to access the service module to install and configure the Cisco SRE-V application.

Cisco SRE-V provides the following configuration options:

- MGF Layer 2 Switched Configuration—This configuration option provides faster performance and has no impact on the router CPU because the traffic goes through the EtherSwitch rather than the router. It supports all Layer 2 functions, such as broadcasting. You must purchase a EtherSwitch EHWIC or EtherSwitch Service Module to use this configuration option.
Configuring the Cisco SRE Service Module Interfaces

Chapter 3      Configuring the Cisco SRE Service Module Interfaces

Cisco IOS Layer 3 Routed Configuration—Choose one of the following options:

- Cisco IOS Layer 3 Routed Configuration with Devices in Different Subnets—Choose this configuration option if you want to add the VMware vSphere Hypervisor™ and the virtual servers in one branch subnet; and the client PCs in another branch subnet. This configuration option does not require additional equipment; however, it has an impact on the router CPU.

- Cisco IOS Layer 3 Routed Configuration with Devices in the Same Subnet—Choose this configuration option if you want to add the VMware vSphere Hypervisor™ and the virtual servers in the same branch subnet as the client PCs. This configuration option does not require additional equipment; however, it has an impact on the router CPU. This option is complex, and some of the Layer 2 functions, such as broadcasting, are not supported.

- External Interface Configuration—This configuration option is simple to configure and low in cost, and has no impact on the router CPU. However, it requires extra cabling and an extra Gigabit Ethernet switchport on the external switch. In addition, you cannot use Cisco IOS features on the VMware vSphere Hypervisor™ networks (for example, you cannot put a virtual machine into a DMZ), and you cannot take advantage of the hardware TCP/IP/UDP/iSCSI off load features that are available on the internal interfaces.

For the Cisco IOS service-module commands to take effect, make sure that the Management Network VMkernel port group is configured to use the vSwitch that has the PCIe interface as the uplink. We recommend that you do not change the default VMkernel port group name, which is Management Network.

See the following sections for more information:

- MGF Layer 2 Switched Configuration—Recommended, page 3-4
- Cisco IOS Layer 3 Routed Configuration Options, page 3-11
- External Interface Configuration, page 3-23

MGF Layer 2 Switched Configuration—Recommended

Figure 3-1 shows the traffic flow in the MGF Layer 2 switched configuration. The MGF backplane switch connects the virtual network across multiple hypervisors and allows direct access to the LAN through Cisco EtherSwitch EHWICs or EtherSwitch Service Modules, without sending the traffic through the router CPU. For supported Cisco EtherSwitch EHWICs and EtherSwitch Service Modules, see Table 1-2.
Figure 3-2 shows the location of the IP addresses.

To access the VMware vSphere Hypervisor™ through the ISR G2, you must provide two IP addresses: One IP address is of the interface that connects the router to the VMware vSphere Hypervisor™; and the other IP address is of the VMware vSphere Hypervisor™.

The virtual machines are accessed through the MGF interface. The port groups on a vSwitch in the VMware vSphere Hypervisor™ can be assigned to corresponding VLAN interfaces in Cisco IOS. For example, port group 50 in the VMware vSphere Hypervisor™ can be assigned to VLAN 50 in Cisco IOS.

**Figure 3-2 IP Address Location**

<table>
<thead>
<tr>
<th>IP Address of the Interface that Connects the Router to the Hypervisor</th>
<th>Hypervisor IP Address</th>
</tr>
</thead>
<tbody>
<tr>
<td>VLAN IP Addresses</td>
<td>vSwitch0</td>
</tr>
<tr>
<td>Host Router</td>
<td></td>
</tr>
<tr>
<td>Virtual Machine Port Groups</td>
<td>vSwitch1</td>
</tr>
<tr>
<td>Cisco SRE-V</td>
<td></td>
</tr>
</tbody>
</table>

**PREREQUISITES**

See the “Prerequisites for Configuring the Cisco SRE Service Module Interfaces” section on page 3-3.

**SUMMARY STEPS**

From the Host-Router CLI, enter:
1. enable
2. configure terminal

Configure slot/0 of the VMware vSphere Hypervisor™
1. interface sm slot/0
2. ip address router-to-hypervisor-interface-IP-address subnet-mask
   or
   [ip unnumbered type number]
3. service-module ip address hypervisor-ip-address subnet-mask
4. service-module ip default-gateway hypervisor-gateway-ip-address
5. no shut
6. exit
7. [ip route hypervisor-ip-address subnet-mask sm slot/0]
Configure slot/1 of the VMware vSphere Hypervisor™
1. interface sm slot/1
2. switchport mode trunk
3. [switchport trunk allowed vlan vlan_numbers]
4. exit

Configure VLANs
1. configure terminal
2. interface vlan vlan_number
3. ip address vlan-ip-address subnet mask
4. no shut
5. end

Save Configuration
1. copy running-config startup-config
2. show running-config

DETAILED STEPS

<table>
<thead>
<tr>
<th>Command or Action</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>From the Host-Router CLI</td>
<td></td>
</tr>
<tr>
<td><strong>Step 1</strong> enable &lt;password&gt;</td>
<td>Enters privileged EXEC mode on the host router. Enter your password if prompted.</td>
</tr>
<tr>
<td><strong>Example:</strong></td>
<td></td>
</tr>
<tr>
<td>Router&gt; enable</td>
<td></td>
</tr>
<tr>
<td>Router&gt; &lt;password&gt;</td>
<td></td>
</tr>
<tr>
<td>Router#</td>
<td></td>
</tr>
<tr>
<td><strong>Step 2</strong> configure terminal</td>
<td>Enters global configuration mode on the host router.</td>
</tr>
<tr>
<td><strong>Example:</strong></td>
<td></td>
</tr>
<tr>
<td>Router# configure terminal</td>
<td></td>
</tr>
</tbody>
</table>

Configure slot/0 of the VMware vSphere Hypervisor™

<table>
<thead>
<tr>
<th>Command or Action</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Step 1</strong> interface sm slot/0</td>
<td>Enters interface configuration mode for the slot and port where the Cisco SRE Service Module resides.</td>
</tr>
<tr>
<td><strong>Example:</strong></td>
<td></td>
</tr>
<tr>
<td>Router(config)# interface sm 1/0</td>
<td></td>
</tr>
</tbody>
</table>
## Chapter 3  Configuring the Cisco SRE Service Module Interfaces

### Configuring the Cisco SRE Service Module Interfaces

<table>
<thead>
<tr>
<th>Step</th>
<th>Command or Action</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td><code>ip address</code></td>
<td>Specifies the IP address of the interface that connects the router to the VMware vSphere Hypervisor™. See Figure 3-2.</td>
</tr>
<tr>
<td></td>
<td><code>router-to-hypervisor-interface-IP-address</code></td>
<td>- <code>router-to-hypervisor-interface-IP-address</code>—IP address of the interface that connects the router to the VMware vSphere Hypervisor™.</td>
</tr>
<tr>
<td></td>
<td><code>subnet-mask</code></td>
<td>- <code>subnet-mask</code>—Subnet mask to append to the IP address.</td>
</tr>
<tr>
<td></td>
<td>or</td>
<td>(Optional) The <code>ip unnumbered</code> command enables IP processing on an interface without assigning an explicit IP address to that interface.</td>
</tr>
<tr>
<td></td>
<td><code>[ip unnumbered type number]</code></td>
<td>- <code>type</code>—Type of interface on which the router has an assigned IP address.</td>
</tr>
<tr>
<td></td>
<td>Example:</td>
<td>- <code>number</code>—Number of the interface on which the router has an assigned IP address.</td>
</tr>
<tr>
<td></td>
<td>Router(config-if)# ip address 10.0.0.100 255.255.255.0</td>
<td>- <code>Note</code> The unnumbered interface must be unique. It cannot be another unnumbered interface.</td>
</tr>
<tr>
<td></td>
<td>or</td>
<td><strong>Caution</strong> The <code>ip unnumbered</code> command creates a point-to-point interface between devices. Broadcasting is not supported.</td>
</tr>
<tr>
<td></td>
<td>Router(config-if)# ip unnumbered gigabitethernet 1/0</td>
<td><strong>Note</strong> If you use the <code>ip unnumbered</code> command, you must use the <code>ip route</code> <code>hypervisor-ip-address subnet-mask sm slot/0</code> command to create a static route. See Step 7.</td>
</tr>
<tr>
<td>3</td>
<td><code>service-module ip address</code></td>
<td>Specifies the IP address of the VMware vSphere Hypervisor™.</td>
</tr>
<tr>
<td></td>
<td><code>hypervisor-ip-address</code></td>
<td>- <code>hypervisor-ip-address</code>—IP address of the VMware vSphere Hypervisor™. See Figure 3-2.</td>
</tr>
<tr>
<td></td>
<td><code>subnet-mask</code></td>
<td>- <code>subnet-mask</code>—Subnet mask to append to the IP address; must be in the same subnet as the host router.</td>
</tr>
<tr>
<td></td>
<td>Example:</td>
<td>- <code>Note</code> If you use the <code>ip unnumbered</code> command, you must use the <code>ip route</code> <code>hypervisor-ip-address subnet-mask sm slot/0</code> command to create a static route. See Step 7.</td>
</tr>
<tr>
<td></td>
<td>Router(config-if)# service-module ip address 10.0.0.1 255.255.255.0</td>
<td>- <code>Caution</code> The <code>ip unnumbered</code> command creates a point-to-point interface between devices. Broadcasting is not supported.</td>
</tr>
<tr>
<td>4</td>
<td><code>service-module ip default-gateway</code></td>
<td>Specifies the IP address of the default gateway for the VMware vSphere Hypervisor™.</td>
</tr>
<tr>
<td></td>
<td><code>hypervisor-gateway-ip-address</code></td>
<td>- <code>hypervisor-gateway-ip-address</code>—IP address for the default gateway router.</td>
</tr>
<tr>
<td></td>
<td>Example:</td>
<td>- <code>Note</code> If you use the <code>ip unnumbered</code> command, you must use the <code>ip route</code> <code>hypervisor-ip-address subnet-mask sm slot/0</code> command to create a static route. See Step 7.</td>
</tr>
<tr>
<td></td>
<td>Router(config-if)# service-module ip default-gateway 10.0.0.100</td>
<td>- <strong>Caution</strong> The <code>ip unnumbered</code> command creates a point-to-point interface between devices. Broadcasting is not supported.</td>
</tr>
<tr>
<td>5</td>
<td><code>no shut</code></td>
<td>Causes the interface to be administratively up.</td>
</tr>
<tr>
<td></td>
<td>Example:</td>
<td>- <code>Note</code> If you use the <code>ip unnumbered</code> command, you must use the <code>ip route</code> <code>hypervisor-ip-address subnet-mask sm slot/0</code> command to create a static route. See Step 7.</td>
</tr>
<tr>
<td></td>
<td>Router(config-if)# no shut</td>
<td>- <code>Caution</code> The <code>ip unnumbered</code> command creates a point-to-point interface between devices. Broadcasting is not supported.</td>
</tr>
</tbody>
</table>
### Chapter 3  Configuring the Cisco SRE Service Module Interfaces

#### Command or Action | Purpose
--- | ---
**Step 6** | exit
**Example:**
Router(config)# exit
Returns to global configuration mode on the host router.

**Step 7** | [ip route hypervisor-ip-address subnet-mask sm slot/0]
**Example:**
Router(config)# ip route 10.0.0.1 255.255.255.255 SM1/0
Creates a static route.
If you used the `ip unnumbered` command in *Step 2*, you must use the `ip route hypervisor-ip-address subnet-mask sm slot/0` command to create a static route.

- **hypervisor-ip-address subnet-mask**—IP address and subnet mask of the VMware vSphere Hypervisor™.
- **slot/0**—slot and port where the Cisco SRE Service Module resides.

Configure slot/1 of the VMware vSphere Hypervisor™

**Step 1** | interface sm slot/1
**Example:**
Router(config)# interface sm 1/1
Enters interface configuration mode for the slot and port where the Cisco SRE Service Module resides.

**Step 2** | switchport mode trunk
**Example:**
Router(config-if)# switchport mode trunk
Puts the port into permanent trunking mode. The default configuration is access mode.

**Step 3** | [switchport trunk allowed vlan vlan_numbers]
**Example:**
Router(config-if)# switchport trunk allowed vlan 1,2,40,60,1002-1005
(Optional) Allows trunking on the specified VLANs.

- **vlan_numbers**—VLAN numbers on which you want to allow trunking.

**Step 4** | exit
**Example:**
Router(config)# exit
Returns to global configuration mode on the host router.

Configure VLANs

**Step 1** | configure terminal
**Example:**
Router# configure terminal
Enters global configuration mode on the host router.

**Step 2** | interface vlan vlan_number
**Example:**
Router(config)# interface vlan 40
Enters VLAN configuration mode for the specified VLAN number.
### Command or Action | Purpose
--- | ---
**Step 3** | **ip address vlan-ip-address subnet-mask**
Example: Router(config-if)# ip address 40.0.0.100 255.255.255.0
| Specifies the IP address for the VLAN.  
- **vlan-ip-address**—IP address for the VLAN.  
- **subnet-mask**—Subnet mask to append to the IP address.  

**Step 4** | **no shut**
Example: Router(config-if)# no shut
| Causes the interface to be administratively up.  

**Step 5** | **end**
Example: Router(config-if)# end
| Returns to global configuration mode on the host router.  

**Save Configuration**

**Step 1** | **copy running-config startup-config**
Example: Router# copy running-config startup-config
| Saves the new running configuration of the router as the startup configuration.  

**Step 2** | **show running-config**
Example: Router# show running-config
| Displays the running configuration of the router so that you can verify the address configurations.
Example

Figure 3-3 shows an example of the MGF Layer 2 switched configuration.

- The left pane shows an example of the Cisco IOS commands that you configure in the sm 1/0, sm 1/1, and VLAN interfaces.
- The right pane shows that the configuration is applied to the VMware vSphere Hypervisor™. The bottom area in the right pane shows the configuration for the Microsoft Windows Servers that are configured using the standard Microsoft Windows network configuration setup process. These Microsoft Windows Servers run as virtual machines.

Note

The IP addresses in the configuration example are for reference only and might not be valid.

Related Topic

- Downloading the Cisco SRE-V Software, page 4-4
Cisco IOS Layer 3 Routed Configuration Options

Figure 3-4 shows the traffic flow in the Cisco IOS Layer 3 routed configuration. The MGF backplane switch forwards the traffic to the router CPU.

**Figure 3-4 Traffic Flow in the Cisco IOS Layer 3 Routed Configuration**

You can either add the VMware vSphere Hypervisor™ and the virtual servers in one branch subnet, and the client PCs in another branch subnet; or you can add all of the devices in the same branch subnet. Depending on which branch subnet you choose to add the devices, the configuration commands that you must use vary. See the following sections for the Cisco IOS Layer 3 routed configuration options:

- Cisco IOS Layer 3 Routed Configuration—Devices in Different Branch Subnets, page 3-11
- Cisco IOS Layer 3 Routed Configuration—Devices in the Same Branch Subnet, page 3-16

**Cisco IOS Layer 3 Routed Configuration—Devices in Different Branch Subnets**

Use this configuration option if you want to add the VMware vSphere Hypervisor™ and the virtual servers in one branch subnet, and the client PCs in another branch subnet.

When you assign a subnet to the VMware vSphere Hypervisor™ and to the virtual servers, that subnet is automatically added to the routing table as a directly connected route. As long as the client PCs are on a subnet that is reachable from the router, no additional routing configuration is necessary. Typically, the client PCs are on a subnet of the onboard Ethernet interface, which is also automatically added to the routing table as a directly connected route. Therefore, the router sends traffic between the subnet of the VMware vSphere Hypervisor™ and the virtual server, and the subnet of the client PCs without any static route or routing protocol configuration.

**PREREQUISITES**

See the “Prerequisites for Configuring the Cisco SRE Service Module Interfaces” section on page 3-3.

**SUMMARY STEPS**

From the Host-Router CLI, enter:

1. `enable`
2. `configure terminal`

Configure `slot/0` of the VMware vSphere Hypervisor™

1. `interface sm slot/0`
2. `ip address router-to-hypervisor-interface-IP-address subnet-mask`
3. service-module ip address hypervisor-ip-address subnet-mask
4. service-module ip default-gateway hypervisor-gateway-ip-address
5. no shut
6. exit

Configure slot/1 of the VMware vSphere Hypervisor™
1. interface sm slot/1
2. switchport mode trunk
3. [switchport trunk allowed vlan vlan_numbers]
4. exit

Configure VLANs
1. configure terminal
2. interface vlan vlan_number
3. ip address vlan-ip-address subnet mask
4. no shut
5. exit

Configure Gigabit Ethernet slot/port
1. interface gigabitethernet slot/port sub-interface
2. ip address branch-VLAN-ip-address subnet-mask
3. encapsulation dot1q vlan-id
4. exit

Save Configuration
1. copy running-config startup-config
2. show running-config

DETAILED STEPS

<table>
<thead>
<tr>
<th>Command or Action</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Step 1</strong></td>
<td>Enters privileged EXEC mode on the host router. Enter your password if prompted.</td>
</tr>
<tr>
<td><strong>enable</strong></td>
<td></td>
</tr>
<tr>
<td>&lt;password&gt;</td>
<td></td>
</tr>
<tr>
<td><strong>Example:</strong></td>
<td></td>
</tr>
<tr>
<td>Router&gt; enable</td>
<td></td>
</tr>
<tr>
<td>Router&gt; &lt;password&gt;</td>
<td></td>
</tr>
<tr>
<td>Router#</td>
<td></td>
</tr>
<tr>
<td><strong>Step 2</strong></td>
<td>Enters global configuration mode on the host router.</td>
</tr>
<tr>
<td><strong>configure terminal</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Example:</strong></td>
<td></td>
</tr>
<tr>
<td>Router# configure terminal</td>
<td></td>
</tr>
</tbody>
</table>
### Command or Action

<table>
<thead>
<tr>
<th>Command</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Configure slot/0 of the VMware vSphere Hypervisor</strong>&lt;sup&gt;TM&lt;/sup&gt;</td>
<td>Enters interface configuration mode for the slot and port where the Cisco SRE Service Module resides.</td>
</tr>
</tbody>
</table>

#### Step 1

**interface sm slot/0**

**Example:**

```
Router(config)# interface sm 1/0
```

#### Step 2

**ip address**

```
router-to-hypervisor-interface-IP-address subnet-mask
```

**Example:**

```
Router(config-if)# ip address 10.0.0.100 255.255.255.0
```

#### Step 3

**service-module ip address**

```
hypervisor-ip-address subnet-mask
```

**Example:**

```
Router(config-if)# service-module ip address 10.0.0.1 255.255.255.0
```

#### Step 4

**service-module ip default-gateway**

```
hypervisor-gateway-ip-address
```

**Example:**

```
Router(config-if)# service-module ip default-gateway 10.0.0.100
```

#### Step 5

**no shut**

**Example:**

```
Router(config-if)# no shut
```

#### Step 6

**exit**

**Example:**

```
Router(config)# exit
```

### Configure slot/1 of the VMware vSphere Hypervisor<sup>TM</sup>

#### Step 1

**interface sm slot/1**

**Example:**

```
Router(config)# interface sm 1/1
```

#### Step 2

**switchport mode trunk**

**Example:**

```
Router(config-if)# switchport mode trunk
```

---

*Note:* The default configuration is access mode. Access mode works with native VLAN, which is VLAN 1 for the Cisco SRE Service Modules.
<table>
<thead>
<tr>
<th>Step 3</th>
<th>Command or Action</th>
<th>Purpose</th>
</tr>
</thead>
</table>
|        | `switchport trunk allowed vlan vlan_numbers` | (Optional) Allows trunking on the specified VLANs.  
|        |  
|        | Example:  
|        | `Router(config-if)# switchport mode trunk`  
|        | `Router(config-if)# switchport trunk allowed vlan 1-2,40,60,1002-1005` |  
| Step 4 | `exit` | Returns to global configuration mode on the host router. |
|        |  
|        | Example:  
|        | `Router(config)# exit` |  

### Configure VLANs

<table>
<thead>
<tr>
<th>Step 1</th>
<th>Command or Action</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td><code>configure terminal</code></td>
<td>Enters global configuration mode on the host router.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
|        | Example:  
|        | `Router# configure terminal` |  
| Step 2 | `interface vlan vlan_number` | Enters VLAN configuration mode for the specified VLAN number. |
|        |  
|        | Example:  
|        | `Router(config)# interface vlan 40` |  
| Step 3 | `ip address vlan-ip-address subnet-mask` | Specifies the IP address for the VLAN.  
|        |  
|        | Example:  
|        | `Router(config-if)# ip address 40.0.0.100 255.255.255.0` |  
| Step 4 | `no shut` | Causes the interface to be administratively up. |
|        |  
|        | Example:  
|        | `Router(config-if)# no shut` |  
| Step 5 | `exit` | Returns to global configuration mode on the host router. |
|        |  
|        | Example:  
|        | `Router(config)# exit` |  

### Configure Gigabit Ethernet slot/port

<table>
<thead>
<tr>
<th>Step 1</th>
<th>Command or Action</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td><code>interface gigabitethernet slot/port sub-interface</code></td>
<td>Enters Gigabit Ethernet configuration mode for the specified sub interface.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
|        | Example:  
|        | `Router(config)# interface gigabitethernet 0/1.120` |  
| Step 2 | `ip address branch-VLAN-ip-address subnet-mask` | Configures the IP address for the specific branch VLAN. |
|        |  
|        | Example:  
|        | `Router(config-if)# ip address 80.80.120.1 255.255.255.0` |  

---

**Command or Action**

- `switchport mode trunk`
- `switchport trunk allowed vlan vlan_numbers`
- `exit`
- `configure terminal`
- `interface vlan vlan_number`
- `ip address vlan-ip-address subnet-mask`
- `no shut`
- `exit`
- `interface gigabitethernet slot/port sub-interface`
- `ip address branch-VLAN-ip-address subnet-mask`
Chapter 3  Configuring the Cisco SRE Service Module Interfaces

Configuring the Cisco SRE Service Module Interfaces

### Example

Figure 3-5 shows an example of the Cisco IOS Layer 3 routed configuration in which the VMware vSphere Hypervisor™ and the virtual servers are in one branch subnet; and the client PCs are in another branch subnet.

- The left pane shows an example of the Cisco IOS commands that you configure in the sm 1/0, sm 1/1, and VLAN interfaces.
- The right pane shows that the configuration is applied to the VMware vSphere Hypervisor™. The bottom area in the right pane shows the configuration for the Microsoft Windows Servers that are configured using the standard Microsoft Windows network configuration setup process. These Microsoft Windows Servers run as virtual machines.

### Note

The IP addresses in the configuration example are for reference only and might not be valid.
Cisco IOS Layer 3 Routed Configuration—Devices in the Same Branch Subnet

Use this configuration option if you want to add the VMware vSphere Hypervisor™ and the virtual servers in the same branch subnet as the client PCs.

Use the `ip unnumbered` interface configuration to place the VMware vSphere Hypervisor™ and the virtual servers on the same subnet as the client PCs. Because the `ip unnumbered` interface configuration creates two interfaces with the same subnet in Cisco IOS, you must also configure static routes for the VMware vSphere Hypervisor™ and the virtual servers.

Related Topics
- Cisco IOS Layer 3 Routed Configuration—Devices in the Same Branch Subnet, page 3-16
- Downloading the Cisco SRE-V Software, page 4-4
PREREQUISITES

See the “Prerequisites for Configuring the Cisco SRE Service Module Interfaces” section on page 3-3.

SUMMARY STEPS

From the Host-Router CLI, enter:
1. enable
2. configure terminal

Configure slot/0 of the VMware vSphere Hypervisor™
1. interface sm slot/0
2. ip unnumbered gigabitethernet slot/port sub-interface
3. service-module ip address hypervisor-ip-address subnet-mask
4. service-module ip default-gateway hypervisor-gateway-ip-address
5. exit

Configure slot/1 of the VMware vSphere Hypervisor™
1. interface sm slot/1
2. switchport mode trunk
3. [switchport trunk allowed vlan vlan_numbers]
4. exit

Configure VLANs
1. configure terminal
2. interface vlan vlan_number
3. ip unnumbered gigabitethernet slot/port sub-interface
4. exit
Configure GE slot/port
1. interface gigabitethernet slot/port sub-interface
2. ip address branch-VLAN-ip-address subnet-mask
3. encapsulation dot1q vlan-id
4. exit
5. ip route virtual-machine-ip-address subnet-mask vlan vlan_number
6. ip route hypervisor-ip-address subnet-mask sm slot/0
7. exit

Save Configuration
1. copy running-config startup-config
2. show running-config

DETAILED STEPS

<table>
<thead>
<tr>
<th>Command or Action</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>From the Host-Router CLI</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Step 1</strong></td>
<td>enable &lt;password&gt;</td>
</tr>
<tr>
<td><strong>Example:</strong></td>
<td>Router&gt; enable &lt;password&gt; Router#</td>
</tr>
<tr>
<td></td>
<td>Enters privileged EXEC mode on the host router. Enter your password if prompted.</td>
</tr>
<tr>
<td><strong>Step 2</strong></td>
<td>configure terminal</td>
</tr>
<tr>
<td><strong>Example:</strong></td>
<td>Router# configure terminal</td>
</tr>
<tr>
<td></td>
<td>Enters global configuration mode on the host router.</td>
</tr>
<tr>
<td><strong>Configure slot/0 of the VMware vSphere Hypervisor™</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Step 1</strong></td>
<td>interface sm slot/0</td>
</tr>
<tr>
<td><strong>Example:</strong></td>
<td>Router(config)# interface sm 1/0</td>
</tr>
<tr>
<td></td>
<td>Enters interface configuration mode for the slot and port where the Cisco SRE Service Module resides.</td>
</tr>
</tbody>
</table>
### Command or Action

<table>
<thead>
<tr>
<th>Step</th>
<th>Command or Action</th>
<th>Purpose</th>
</tr>
</thead>
</table>
| Step 2 | `ip unnumbered gigabitethernet slot/port sub-interface` | Enables IP processing on an interface without assigning an explicit IP address to that interface. The traffic is forwarded to and from a Gigabit Ethernet sub-interface.  
  - `slot/port`—Position of the Gigabit Ethernet interface in the router chassis.  
  - `sub-interface`—Number of the Gigabit Ethernet sub-interface on which the router has an assigned IP address.  
  **Note:** The unnumbered interface must be unique. It cannot be another unnumbered interface.  
  **Caution:** The `ip unnumbered` command creates a point-to-point interface between devices. Broadcasting is not supported. |
| Step 3 | `service-module ip address hypervisor-ip-address subnet-mask` | Specifies the IP address of the VMware vSphere Hypervisor™.  
  - `hypervisor-ip-address`—IP address of the VMware vSphere Hypervisor™. See Figure 3-2.  
  - `subnet-mask`—Subnet mask to append to the IP address; must be in the same subnet as the host router. |
| Step 4 | `service-module ip default-gateway hypervisor-gateway-ip-address` | Specifies the IP address of the default gateway for the VMware vSphere Hypervisor™.  
  - `hypervisor-gateway-ip-address`—IP address for the default gateway router. |
| Step 5 | `exit` | Exits interface mode. |

#### Configure slot/1 of the VMware vSphere Hypervisor™

<table>
<thead>
<tr>
<th>Step</th>
<th>Command or Action</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 1</td>
<td><code>interface sm slot/1</code></td>
<td>Enters interface configuration mode for the slot and port where the Cisco SRE Service Module resides.</td>
</tr>
</tbody>
</table>
| Step 2 | `switchport mode trunk` | Puts the port into permanent trunking mode.  
  The default configuration is access mode. Access mode works with native VLAN, which is VLAN 1 for the Cisco SRE Service Modules. |
| Step 3 | `[switchport trunk allowed vlan vlan_numbers]` | (Optional) Allows trunking on the specified VLANs.  
  - `vlan_numbers`—VLAN numbers on which you want to allow trunking. |
### Command or Action

<table>
<thead>
<tr>
<th>Step</th>
<th>Command or Action</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>4</td>
<td>exit</td>
<td>Returns to global configuration mode on the host router.</td>
</tr>
<tr>
<td>1</td>
<td>configure terminal</td>
<td>Enters global configuration mode on the host router.</td>
</tr>
<tr>
<td>2</td>
<td>interface vlan vlan_number</td>
<td>Enters VLAN configuration mode for the specified VLAN number.</td>
</tr>
</tbody>
</table>
| 3    | ip unnumbered gigabitethernet slot/port sub-interface | Enables IP processing on an interface without assigning an explicit IP address to that interface. The traffic is forwarded to and from a Gigabit Ethernet sub-interface.  
- slot/port—Position of the Gigabit Ethernet interface in the router chassis.  
- sub-interface—Number of the Gigabit Ethernet sub interface on which the router has an assigned IP address.  
**Note**  
The unnumbered interface must be unique. It cannot be another unnumbered interface.  
**Caution**  
The `ip unnumbered` command creates a point-to-point interface between devices. Broadcasting is not supported. |
| 4    | exit                                    | Exits interface mode.                                                  |

### Configure Gigabit Ethernet slot/port

<table>
<thead>
<tr>
<th>Step</th>
<th>Command or Action</th>
<th>Purpose</th>
</tr>
</thead>
</table>
| 1    | interface gigabitethernet slot/port sub-interface | Enters Gigabit Ethernet configuration mode for the specified sub interface.  
- slot/port—Position of the Gigabit Ethernet interface in the router chassis.  
- sub-interface—Number of the Gigabit Ethernet interface on which the router has an assigned IP address. |
| 2    | ip address branch-VLAN-ip-address subnet-mask | Configures the IP address for the specific branch VLAN.  
- branch-VLAN-ip-address subnet-mask—IP address for the specific branch VLAN. This IP address can be used as the default gateway for virtual machines in the VLAN defined in Step 5. |
### Step 3: Configuring the Cisco SRE Service Module Interfaces

<table>
<thead>
<tr>
<th>Command or Action</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>encapsulation dot1q vlan-id</strong></td>
<td>Enables IEEE 802.1Q encapsulation of traffic on the specified subinterface in VLANs.</td>
</tr>
<tr>
<td><strong>Example:</strong></td>
<td></td>
</tr>
<tr>
<td>Router(config-if)# encapsulation dot1q 40</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Step 4</strong></th>
<th>Exits interface mode.</th>
</tr>
</thead>
<tbody>
<tr>
<td>exit</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Step 5</strong></th>
<th>Creates a static route entry for the virtual machine.</th>
</tr>
</thead>
<tbody>
<tr>
<td>ip route virtual-machine-ip-address subnet-mask vlan vlan_number</td>
<td></td>
</tr>
<tr>
<td><strong>Example:</strong></td>
<td></td>
</tr>
<tr>
<td>Router(config)# ip route 40.0.0.2 255.255.255.0 vlan 40</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Step 6</strong></th>
<th>Creates a static route.</th>
</tr>
</thead>
<tbody>
<tr>
<td>ip route hypervisor-ip-address subnet-mask sm slot/0</td>
<td></td>
</tr>
<tr>
<td><strong>Example:</strong></td>
<td></td>
</tr>
<tr>
<td>Router(config)# ip route 10.0.0.1 255.255.255.255 SM1/0</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Step 7</strong></th>
<th>Exits interface mode.</th>
</tr>
</thead>
<tbody>
<tr>
<td>exit</td>
<td></td>
</tr>
</tbody>
</table>

### Command or Action Purpose

**Command or Action**

**Purpose**

<table>
<thead>
<tr>
<th>Step 1 copy running-config startup-config</th>
<th>Saves the new running configuration of the router as the startup configuration.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Example:</strong></td>
<td>Router# copy running-config startup-config</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Step 2 show running-config</th>
<th>Displays the running configuration of the router so that you can verify the address configurations.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Example:</strong></td>
<td>Router# show running-config</td>
</tr>
</tbody>
</table>
Example

**Figure 3-6** shows an example of the Cisco IOS Layer 3 routed configuration where the VMware vSphere Hypervisor™ and the virtual servers are in the same branch subnet as the client PCs.

- The left pane shows an example of the Cisco IOS commands that you configure in the sm 1/0, sm 1/1, VLAN, and Gigabit Ethernet interfaces.
- The right pane shows that the configuration is applied to the VMware vSphere Hypervisor™. The bottom area in the right pane shows the configuration for the Microsoft Windows Servers that are configured using the standard Microsoft Windows network configuration setup process. These Microsoft Windows Servers run as virtual machines.

**Note**

The IP addresses in the configuration example are for reference only and might not be valid.

**Figure 3-6**  
Cisco IOS Layer 3 Routed Configuration—Devices in the Same Subnet

```
interface SM1/0
 ip unnumbered gigabitethernet 0/0.1
 service-module ip address 10.0.0.1 255.255.255.0
 service-module ip default-gateway 10.0.0.100
 interface gigabitethernet 0/0.1
 ip address 10.0.0.100
 ip route 10.0.0.1 255.255.255.255 SM1/0

interface SM1/1
 switchport mode trunk

interface vlan 40
 ip unnumbered gigabitethernet 0/0.40
 interface gigabitethernet 0/0.40
 ip address 40.0.0.100 255.255.255.0
 encapsulation dot1q 40
 ip route 40.0.0.2 255.255.255.255 vlan 40

interface vlan 60
 ip unnumbered gigabitethernet 0/0.60
 interface gigabitethernet 0/0.60
 ip address 60.0.0.100 255.255.255.0
 encapsulation dot1q 60
 ip route 60.0.0.2 255.255.255.255 vlan 60
```

Related Topic

- Downloading the Cisco SRE-V Software, page 4-4
External Interface Configuration

The Cisco IOS commands for this configuration are the same as the commands for the “MGF Layer 2 Switched Configuration—Recommended” section on page 3-4 or the “Cisco IOS Layer 3 Routed Configuration Options” section on page 3-11, except for the following:

- The IP address of the virtual machine is on a network that is connected to the external interface.
- The virtual machine default gateway points to the external interface.
- The static route entry for the virtual machine, which is configured in the Cisco IOS Layer 3 Routed Configuration, is not required.

Figure 3-7 shows the traffic flow in the external interface configuration. The service module sends the traffic through the external interface.

To configure the external interface, complete the following steps:

**Step 1** To configure access to the VMware vSphere Hypervisor™, use the configuration commands provided in one of the following sections:

- “MGF Layer 2 Switched Configuration—Recommended” section on page 3-4
  or
- “Cisco IOS Layer 3 Routed Configuration Options” section on page 3-11

**Step 2** Use the vSphere Client GUI to configure access to the virtual machine through the external interface. For instructions, see the vSphere Client online help.
Example

Figure 3-8 shows an example of the external interface configuration.

Note
The IP addresses in the configuration example are for reference only and might not be valid.

Reload, Reset, and Shut Down Commands

To reload, reset, or shut down the Cisco SRE Service Module, choose the common router commands listed in Table 3-1. You might choose to shut down the Cisco SRE Service Module for service reasons or to save energy when it is not being used.

Note
For these Cisco IOS service-module commands to take effect, make sure that the Management Network VMkernel port group is configured to use the vSwitch that has the vmnic1 interface as the uplink.
Chapter 3  Configuring the Cisco SRE Service Module Interfaces

Reload, Reset, and Shut Down Commands

**Note**
- Some shutdown commands can potentially disrupt service. If the command output for such a command displays a confirmation prompt, press Enter to confirm; or type n to cancel, and then press Enter. You can prevent the prompt from being displayed by using the no-confirm keyword.
- Some commands shut down the module or application, and then immediately restart it.

### Table 3-1  Common Shutdown and Startup Commands

<table>
<thead>
<tr>
<th>Configuration Mode</th>
<th>Command</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>Router#</td>
<td>service-module sm slot/0 reload</td>
<td>Gracefully shuts down the Cisco SRE Service Module and then powers it on.</td>
</tr>
<tr>
<td>Router#</td>
<td>service-module sm slot/0 reset</td>
<td>Resets the hardware on the Cisco SRE Service Module. Use this command only to recover from a shutdown or failed state.</td>
</tr>
<tr>
<td>Caution</td>
<td></td>
<td>Using this command does <em>not</em> provide an orderly software shutdown and may impact file operations that are in progress.</td>
</tr>
<tr>
<td>Router#</td>
<td>service-module sm slot/0 shutdown</td>
<td>Shuts down the Cisco SRE Service Module system gracefully. Use this command when removing or replacing a hot-swappable module during online insertion and removal (OIR). See the “Online Insertion and Removal of the Cisco SRE Service Module” section on page 2-3. If the virtual machines on the VMware vSphere Hypervisor™ have VMware tools installed on them, and you issue this command, the virtual machines shut down first, and then the Cisco SRE Service Module shuts down. If the virtual machines do not have VMware tools installed on them, and you issue this command, the virtual machines get powered off first, and then the shutdown signal is sent to the service module. After about two minutes, the Cisco SRE Service Module shuts down.</td>
</tr>
</tbody>
</table>
Understanding RAID Options

When installing the Cisco SRE-V application on a Cisco SRE 900 Service Module, you can choose to store data files on local Redundant Array of Inexpensive Disks (RAID). The available RAID mode options are: RAID 1, RAID 0, and non-RAID.
Note

RAID is not supported on the Cisco SRE 700 Service Module. It is supported on the Cisco SRE 900 Service Module only.

RAID 1
RAID 1 creates a mirrored set of disk drives, where the data in both the disk drives is identical. See Figure 4-1. RAID 1 provides high availability. If one disk drive fails, the other disk drive takes over, preserving the datastore. RAID 1 supports fault tolerance and hot-swapping. When one disk drive fails, you can remove the faulty disk drive and replace it with a new disk drive. See the “Hot-Swapping the Faulty RAID 1 Disk Drive” section on page 7-3.

However, compared to RAID 0, there is less storage space because half of the total potential disk storage space (465 GB) is available and there is a small impact on performance.

Figure 4-1 shows that in RAID 1, the data in Disk 0 and Disk 1 is identical (mirrored).

Figure 4-1  RAID 1 Option—Data in Disk 0 and Disk 1 Is Identical
**RAID 0**

With RAID 0, the data is stored evenly in stripe blocks across two disk drives without redundancy (mirroring). The data in both the disk drives is different. See Figure 4-2.

Compared to RAID 1, RAID 0 provides additional storage because both the disk drives (927 GB) are used to store data. The performance is improved by two times because the read and write operation occurs in parallel within the two disk drives.

However, there is no fault tolerance, error checking, or hot-swapping. If one disk drive fails, the data in the entire array is destroyed. Because there is no error checking or hot-swapping, the array is susceptible to unrecoverable errors.

Figure 4-2 shows that in RAID 0, the data in Disk 0 and Disk 1 is different. The data is evenly divided across Disk 0 and Disk 1 without redundancy.

**Figure 4-2  RAID 0—Data in Disk 0 and Disk 1 Is Different**

Non-RAID

When the disk drives of a computer are not configured as RAID, the computer is in non-RAID mode. Non-RAID mode is also referred to as Just a Bunch of Disks or Just a Bunch of Drives (JBOD). Non-RAID mode does not support fault tolerance, error checking, hot-swapping, or redundancy.
Chapter 4      Installing and Managing the Cisco SRE-V Software

Downloading the Cisco SRE-V Software

Before you begin downloading the Cisco SRE-V software, do the following:

- Make sure that you have the IP address or name of the FTP server in which you want to store the Cisco SRE-V software package file.
- Verify that the FTP server is accessible.

To download the Cisco SRE-V software, complete the following steps:

Step 1 Go to http://www.cisco.com/go/ucse, click Download Software, and then download the Cisco SRE-V files:
- For Cisco SRE 700 Service Module, download the following .zip file:
  sre-v-k9.SPA.smv.1.5.1.zip
- For Cisco SRE 900 Service Module, download the following .zip file:
  sre-v-k9-r.SPA.smv.1.5.1.zip

  where r in the file name stands for RAID. RAID is supported on the Cisco SRE 900 Service Module only.

Table 4-1 provides a summary of the RAID options.

Table 4-1       Summary of RAID Options

<table>
<thead>
<tr>
<th>Options</th>
<th>Description</th>
<th>Advantages</th>
<th>Disadvantages</th>
</tr>
</thead>
<tbody>
<tr>
<td>RAID 1</td>
<td>Mirrored set of disk drives, where the data in both the disks is identical.</td>
<td>• High availability</td>
<td>• Storage—465 GB</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Fault tolerance</td>
<td>• Small performance impact</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Hot-swapping</td>
<td></td>
</tr>
<tr>
<td>RAID 0</td>
<td>Data is stored evenly in stripe blocks across two or more disks without</td>
<td>• Storage—927 GB</td>
<td>• No error checking</td>
</tr>
<tr>
<td></td>
<td>redundancy (mirroring). The data in both the disk drives is different.</td>
<td>• Double performance</td>
<td>• No fault tolerance</td>
</tr>
<tr>
<td>Non-RAID</td>
<td>Disk drives of a computer are not configured as RAID. Also referred to as</td>
<td>• Portable</td>
<td>• No hot-swapping</td>
</tr>
<tr>
<td></td>
<td>JBOD.</td>
<td></td>
<td>• No redundancy</td>
</tr>
</tbody>
</table>

Related Topics

- Entering the RAID Management Command Environment, page 7-1
- Hot-Swapping the Faulty RAID 1 Disk Drive, page 7-3
- Downloading the Cisco SRE-V Software, page 4-4
Note

If you use a file extractor tool designed for Windows, such as WinZip, you must disable CR/LF conversion of tar files. For example, in WinZip 9.0, choose Configuration > Miscellaneous, and then uncheck TAR file smart CR/LF conversion.

Step 2

Extract the zip files to an FTP server. All files to be installed must reside in the same directory.

Step 3

Install the Cisco SRE-V software. See the “Installing the Cisco SRE-V Software—Clean Install” section on page 4-5 or the “Upgrading the Cisco SRE-V Software” section on page 4-10 as appropriate.

Related Topics

- Understanding RAID Options, page 4-1
- Installing the Cisco SRE-V Software—Clean Install, page 4-5
- Upgrading the Cisco SRE-V Software, page 4-10

Installing the Cisco SRE-V Software—Clean Install

Caution

Do not use this procedure if you have a previous version of Cisco SRE-V software installed in your system. If you do, you will lose all data. To upgrade to the next version, use the upgrade procedure. See the “Upgrading the Cisco SRE-V Software” section on page 4-10.

Note

- Cisco SRE-V software installation takes approximately 10 minutes. Depending on your network speed, the installation time can vary.
- To view the status of the Cisco SRE-V installation, from the host-router CLI, enter the service-module sm slot/0 status command, as shown in the following example:

  Router# service-module sm 1/0 status

Before you begin installing the Cisco SRE-V software, see the “Understanding RAID Options” section on page 4-1.

To install the Cisco SRE-V software on the Cisco SRE Service Module, complete the following steps.

SUMMARY STEPS

1. enable
2. service-module sm slot/0 install url url
   or
   service-module sm slot/0 install url url argument disk-cfg-mode={raid1 | raid0 | nonraid}
3. [service-module sm slot/0 status]
4. exit
### DETAILED STEPS

<table>
<thead>
<tr>
<th>Command or Action</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Step 1</strong>&lt;br&gt;enable&lt;br&gt;&lt;password&gt;</td>
<td>Enables privileged EXEC mode. Enter your password if prompted.</td>
</tr>
</tbody>
</table>

**Example:**

Router> enable
Router> &lt;password&gt;
Router#

**Step 2**<br>service-module sm slot/0 install url url or

service-module sm slot/0 install url url argument disk-cfg-mode={raid1 | raid0 | nonraid}

**Example of Cisco SRE 900 Service Module:**

Router# service-module sm 2/0 install url ftp://server.com/dir/sre-v-k9-r.SPA.smv.1.5.1.pkg Loading galactica-wql#$s.1/solaria/1.5.1/raid/sre-v-k9-r. SPA.smv.1.5.1.pkg Delete the installed Cisco SRE-V Software and proceed with new installation? [no]: yes Loading solaria/1.5.1/raid/sre-v-k9-r.SPA.smv.1.5.1.pkg.i nstall.sre ![OK - 5994/4096 bytes]

Service module installation

ios_version 15.1(3.22)M0.6,
ios_image c2951-universalk9-mz
pkg_name sre-v-k9-r.SPA.smv.1.5.1.pkg
key_file sre-v-k9-r.SPA.smv.1.5.1.key
helper_file sre-v-installer.SPA.smv.1.5.1
pid SM-SRE-900-K9

Check target platform capabilities

cpu 1865

Please select disk configuration (-1 = nonraid, 0 = raid0, 1 = raid1 ) [-1]:

or

Router# service-module sm 2/0 install url ftp://server.com/dir/sre-v-k9-r.SPA.smv.1.5.1.pkg argument disk-cfg-mode=raid1

Router# service-module sm 2/0 install url ftp://server.com/dir/sre-v-k9-r.SPA.smv.1.5.1.pkg argument disk-cfg-mode=raid0

Router# service-module sm 2/0 install url ftp://server.com/dir/sre-v-k9-r.SPA.smv.1.5.1.pkg argument disk-cfg-mode=nonraid

**Starts the installation of the Cisco SRE-V application. After you enter the install command, you are prompted to choose a disk configuration (RAID mode). The disk configuration options are: 1, 0, or -1.**

- 1 is RAID 1 mode.
- 0 is RAID 0 mode.
- -1 is non-RAID mode

For information about RAID options, see the “Understanding RAID Options” section on page 4-1.

or

Starts the installation of the Cisco SRE-V application in the specified RAID mode. The RAID mode options are: RAID 1, RAID 0, or non-RAID. For information about RAID options, see the “Understanding RAID Options” section on page 4-1.

**Note** RAID is not supported on the Cisco SRE 700 Service Module. RAID is supported on the Cisco SRE 900 Service Module only.

- **slot/port**—Position of the target module in the router chassis. For Cisco SRE Service Module, always use 0 for the port number. Applications are installed into the service module through this port. The slash (/) is required between the slot and port number.

- **url**— Specifies the URL, as defined in RFC 2396 of the server and directory on which the application packages and Tcl script are located. The URL should point to the .pkg file on the FTP server.

In the url, you can choose to use the username and password of the FTP server. For example: ftp://username:password@server.com/dir/ sre-v-k9-r.SPA.smv.1.5.1.pkg.
### Entering and Exiting the VMware vSphere Hypervisor DCUI

After you successfully install Cisco SRE-V 1.5, and you session into the service module, the console interface is displayed. The console interface allows you to access the VMware vSphere Hypervisor™ DCUI to perform Cisco SRE-V configuration. See “Entering and Exiting the VMware vSphere Hypervisor DCUI” section on page 4-7.

If you are a first-time user of the VMware vSphere Hypervisor™, use root for the username; and for the password, leave the field empty. After you login, we recommend that you change the password.

**Related Topics**
- Entering and Exiting the VMware vSphere Hypervisor DCUI, page 4-7
- Understanding RAID Options, page 4-1
- Downloading the Cisco SRE-V Software, page 4-4
- Uninstalling the Cisco SRE-V Software, page 4-8

---

<table>
<thead>
<tr>
<th>Command or Action</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Step 2</strong>&lt;br&gt;(continued)</td>
<td><strong>raid1</strong>—Installs Cisco SRE-V in RAID 1 mode. For more information, see the “RAID 1” section on page 4-2.</td>
</tr>
<tr>
<td><strong>Step 2</strong>&lt;br&gt;(continued)</td>
<td><strong>raid0</strong>—Installs Cisco SRE-V in RAID 0 mode. For more information, see the “RAID 0” section on page 4-3.</td>
</tr>
<tr>
<td><strong>Step 2</strong>&lt;br&gt;(continued)</td>
<td><strong>nonraid</strong>—Installs Cisco SRE-V in non-RAID mode. For more information, see the “Non-RAID” section on page 4-3.</td>
</tr>
</tbody>
</table>

### Example of Cisco SRE 900 Service Module With FTP Credentials in the URL:

```plaintext
Router# service-module sm 2/0 install url ftp://username:password@server.com/dir/sre-v-k9-r.SPA.smv.1.5.1.pkg
```

### Step 3

<table>
<thead>
<tr>
<th>Example:</th>
<th>(Optional) Monitors progress of the installation.</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>service-module sm slot/0 status</code></td>
<td></td>
</tr>
</tbody>
</table>

### Step 4

<table>
<thead>
<tr>
<th>Example:</th>
<th>Exits privileged EXEC mode.</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>service-module sm 2/0 status</code></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Example:</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><code>exit</code></td>
<td>Exits privileged EXEC mode.</td>
</tr>
</tbody>
</table>

---

**Entering and Exiting the VMware vSphere Hypervisor DCUI**

To enter or exit from the VMware vSphere Hypervisor™ DCUI, do the following:

**Step 1**

Use the `service-module sm slot/0 session` command to session into the Cisco SRE Service Module, as shown in the following example:

```plaintext
Router# service-module sm 2/0 session
SRE-Module#
```

The DCUI Welcome page appears.

**Step 2**

If you are a first-time user of the VMware vSphere Hypervisor™, use root for the username; and for the password, leave the field empty. After you login, we recommend that you change the password.

**Step 3**

To exit from the DCUI, press `Ctrl + Shift + 6 + x`. The router prompt appears.
Step 4  From the router prompt, enter the `disconnect` command to disconnect from the DCUI, as shown in the following example:

```
Router# disconnect
```

Step 5  At the confirmation prompt, press `Enter` to confirm the disconnect operation.

---

## Uninstalling the Cisco SRE-V Software

To uninstall the Cisco SRE-V software from the Cisco SRE Service Module, complete the following steps.

⚠️ **Caution**

This procedure erases the disk on the Cisco SRE Service Module and removes the application keys.

### SUMMARY STEPS

1. `enable`
2. `service-module sm slot/0 uninstall`
3. `exit`

### DETAILED STEPS

<table>
<thead>
<tr>
<th>Command or Action</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Step 1</strong> <code>enable</code> <code>&lt;password&gt;</code></td>
<td>Enables privileged EXEC mode. Enter your password if prompted.</td>
</tr>
<tr>
<td><strong>Example:</strong></td>
<td></td>
</tr>
<tr>
<td><code>Router&gt; enable</code></td>
<td></td>
</tr>
<tr>
<td><code>Router&gt; &lt;password&gt;</code></td>
<td></td>
</tr>
<tr>
<td><code>Router#</code></td>
<td></td>
</tr>
<tr>
<td><strong>Step 2</strong> <code>service-module sm slot/0 uninstall</code></td>
<td>Uninstalls the SRE-supported application from the specified Cisco SRE Service Module. This command completely erases the disk on the Cisco SRE Service Module and removes the application keys. It does not remove the application licenses.</td>
</tr>
<tr>
<td><strong>Example:</strong></td>
<td></td>
</tr>
<tr>
<td><code>Router# service-module sm 2/0 uninstall</code></td>
<td></td>
</tr>
</tbody>
</table>

- `slot/port`—Position of the target module in the router chassis. For Cisco SRE Service Module, always use `0` for the port number. Applications are installed into the service module through this port. The slash (`/`) is required between the slot and port number.

**Note** Uninstallation is not complete until the “uninstall complete” message is displayed on the router console. To verify the status of the Cisco SRE-V uninstallation, from the host-router CLI, enter the `service-module sm slot/0 status` command.
Verifying Software Installation or Uninstallation

To view the status of the Cisco SRE-V installation or uninstallation, from the host-router CLI, enter the `service-module sm slot/0 status` command, as shown in the following example:

```
Router# service-module sm 1/0 status
Service Module is Cisco SM1/0
Service Module supports session via TTY line 67
Service Module is in Steady state
Service Module heartbeat-reset is enabled
Getting status from the Service Module, please wait..
Cisco SRE-V Software 1.5.1.0
VMware ESXi 4.1.0 build-348481 running on SRE

Module resource information:
CPU Frequency: 1860 MHz
Memory Size: 4067 MB
Disk 0 Size: 500108 MB
Disk 1 Size: 500108 MB
Disk 2 Size: 1955 MB

No install/uninstall in progress
```

Related Topics

- **Installing the Cisco SRE-V Software—Clean Install**, page 4-5
- **Uninstalling the Cisco SRE-V Software**, page 4-8
Upgrading the Cisco SRE-V Software

To upgrade the Cisco SRE-V software, complete the following steps:

---

**Step 1** Download the appropriate version of the Cisco SRE-V upgrade software. See the “Downloading the Cisco SRE-V Software” section on page 4-4.

**Step 2** Use the `service-module sm slot/0 install url url argument keep-ds` command to install the Cisco SRE-V software, as shown in the following example:

```
Router# service-module sm 2/0 install url ftp://server.com/dir/sre-v-k9-r.SPA.smv.1.5.1.pkg argument keep-ds
```

where `url` is the server and directory on which the application packages and Tcl script are located. The URL should point to the .pkg file on the FTP server.

In the `url`, you can choose to use the username and password of the FTP server. For example:

```
Router# service-module sm 2/0 install url ftp://username:password@server.com/dir/sre-v-k9-r.SPA.smv.1.5.1.pkg argument keep-ds
```

---

**Note** After the upgrade, the content in the disk is retained but you must reconfigure the VMware vSphere Hypervisor™, and then add the virtual machines to the inventory.

---

**Related Topics**

- Cannot View Datastores, page 7-8

Downgrading the Cisco SRE-V Software from Release 1.5 to 1.1

Before you begin the downgrade process, do the following:

- Export the virtual machines to a remote location.

To downgrade from Cisco SRE-V 1.5 to Cisco SRE-V 1.1, complete the following steps:

---

**Step 1** Download the Cisco SRE-V 1.1 software. See the “Downloading the Cisco SRE-V Software” section on page 4-4.

**Step 2** Use the `service-module sm slot/0 install url url` command to install the Cisco SRE-V 1.1 software, as shown in the following example:

```
Router# service-module sm slot/0 install url ftp://server.com/dir/sre-v-k9.smv.1.1.1.pkg
```

where `url` is the server and directory on which the application packages and Tcl script are located. The URL should point to the .pkg file on the FTP server. In the `url`, you can choose to use the username and password of the FTP server. For example:

```
Router# service-module sm slot/0 install url ftp://username:password@server.com/dir/sre-v-k9.smv.1.1.1.pkg
```
Step 3 Choose the RAID mode that you want enabled. During the installation process, you are prompted to choose a disk configuration (RAID mode). The disk configuration options are: 1, 0, or -1.

- 1 is RAID 1 mode.
- 0 is RAID 0 mode.
- -1 is non-RAID mode.

The service module reboots and the Cisco SRE-V 1.1 software is installed.

Step 4 Reconfigure the VMware vSphere Hypervisor™.

Step 5 Import the virtual machines that you had exported.

---

Installing Other Cisco Applications on the Cisco SRE Service Module

Before you begin, do the following:

- Export the virtual machines to a remote location.

To install other Cisco applications on the Cisco SRE Service Module, complete the following steps:

Step 1 Download the application that you want to install on the Cisco SRE Service Module.

Step 2 Download the hardware utility. The hardware utility is used to change the SATA mode from AHCI to IDE.

Step 3 Use the `service-module sm slot/0 install url url/sm-hw-util1.1.x argument sata-mode=ide` command to change the SATA mode from AHCI to IDE:

```
Router# service-module sm slot/0 install url url/sm-hw-util1.1.x argument sata-mode=ide
```

Step 4 Use the `service-module sm slot/0 install url application_url` command to install the software, as shown in the following example:

```
Router# service-module sm slot/0 install url application_url.pkg
```

where `url` is the server and directory on which the application packages and Tcl script are located. The URL should point to the .pkg file on the FTP server.

The service module reboots and the application is installed.
Installing the VMware vSphere Hypervisor Patch or Update Release

VMware vSphere Hypervisor™ patches and update releases are available periodically on an as-needed basis from Cisco.com.

To install the VMware vSphere Hypervisor™ patch or update release, complete the following steps:

**Step 1** Download the patch or update release (as appropriate) from Cisco.com.

*Note* Do not download the patch or update release from VMware.

**Step 2** Use the update utility provided by VMware to install the patch or update release.
CHAPTER

Managing the VMware vSphere Hypervisor License

Last Updated: August 4, 2011

Cisco SRE-V uses the VMware vSphere Hypervisor™ software for virtualization. This chapter provides information about how to manage the VMware vSphere Hypervisor™ license. It contains the following sections:

- VMware vSphere Hypervisor License Overview, page 5-1
- Registering the VMware vSphere Hypervisor License, page 5-2
- Activating the VMware License Key, page 5-4
- Accessing the VMware License Key Information, page 5-4

VMware vSphere Hypervisor License Overview

The following two types of VMware vSphere Hypervisor™ licenses are available:

- VMware vSphere Hypervisor Evaluation License—60-day evaluation license that is bundled with the Cisco SRE-V software image, which you can use to evaluate the hosting environment.
- Permanent VMware vSphere Hypervisor Host License—Perpetual license that can be obtained along with the Cisco SRE-V software image, or can be purchased separately, after the built-in evaluation license expires. After a permanent license is installed, it provides all the permissions necessary, to access the features in the software image. You do not need to upgrade a permanent licence for subsequent releases.

The following types of permanent licenses are available:

- VMware vSphere Hypervisor Host License—Does not provide the ability to manage the VMware vSphere Hypervisor host through vCenter.
- VMware vSphere Hypervisor Host with vCenter Agent License—Provides the ability to manage the VMware vSphere Hypervisor host through vCenter.

For feature license SKUs that are available for Cisco SRE-V, see Table 5-1.

Note

You can convert the VMware vSphere Hypervisor Host license to a VMware vSphere Hypervisor Host with vCenter Agent license by purchasing an upgrade license.
Table 5-1 shows the feature license SKUs that are available for Cisco SRE-V.

**Table 5-1 Feature License SKUs**

<table>
<thead>
<tr>
<th>License SKUs</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Licenses Without vCenter Support</strong></td>
<td></td>
</tr>
<tr>
<td>FL-SRE-V-HOST</td>
<td>VMware vSphere Hypervisor Host paper license purchased with the software.</td>
</tr>
<tr>
<td>FL-SRE-V-HOST=</td>
<td>VMware vSphere Hypervisor Host paper license purchased without the software (spare).</td>
</tr>
<tr>
<td>L-FL-SRE-V-HOST=</td>
<td>VMware vSphere Hypervisor Host electronic license purchased without the software (spare).</td>
</tr>
<tr>
<td><strong>Licenses With vCenter Support</strong></td>
<td></td>
</tr>
<tr>
<td>FL-SRE-V-HOSTVC</td>
<td>Feature license for the VMware vSphere Hypervisor software on the Cisco SRE Service Module, which includes vCenter management support. This license can be purchased with the software.</td>
</tr>
<tr>
<td>FL-SRE-V-HOSTVC=</td>
<td>Feature license for the VMware vSphere Hypervisor software on the Cisco SRE Service Module, which includes vCenter management support (spare).</td>
</tr>
<tr>
<td>L-FL-SRE-V-HOSTVC=</td>
<td>E-delivery feature license for the VMware vSphere Hypervisor software on the Cisco SRE Service Module, which includes vCenter management support (spare).</td>
</tr>
<tr>
<td><strong>Upgrade Licenses to Add vCenter Support</strong></td>
<td></td>
</tr>
<tr>
<td>FL-SRE-V-VC-UPG=</td>
<td>Feature license to upgrade the VMware vSphere Hypervisor software on the Cisco SRE Service Module to enable vCenter management support (spare).</td>
</tr>
<tr>
<td>L-FL-SRE-V-VC-UPG=</td>
<td>E-delivery feature license to upgrade the VMware vSphere Hypervisor software on the Cisco SRE Service Module to enable vCenter management support (spare).</td>
</tr>
</tbody>
</table>

**Related Topics**

- Cisco SRE-V Options, page 1-4
- Registering the VMware vSphere Hypervisor License, page 5-2
- Activating the VMware License Key, page 5-4

## Registering the VMware vSphere Hypervisor License

Use this procedure if you purchased Cisco SRE-V Option 1 (Hardware only) and a spare VMware vSphere Hypervisor™ license from Cisco.com.

When you purchase the spare VMware vSphere Hypervisor™ license, you receive a letter from Cisco Systems, which contains the Activation Code, which you must register with VMware. After, you register the Activation Code, you receive a VMware license key, which you must activate using the vSphere Client GUI.

**Note**

You must register the Activation Code with VMware within 30 days of receipt.
To register the Activation Code and receive the VMware license key, complete the following steps:

---

**Step 1** To register the Activation Code with VMware, go to:

https://www.vmware.com/oem/code.do?Name=CISCOISR-AC.

The VMware Product Registration page opens.

**Step 2** Do one of the following:

- If you are a registered VMware user, enter your credentials, and then click **Sign In**. The VMware Partner Activation Code Registration page opens.
- If you are new to VMware, click the **Register** button. The Register For Your VMware Product page opens. Enter the required information in the fields provided, and then click **Continue**. You receive an e-mail from VMware to Activate your account. Click the **Activate Now** button provided in your e-mail, and then enter your password in the field provided. The VMware Partner Activation Code Registration page opens.

**Step 3** Enter the Activation Code that you received from Cisco Systems in the Partner Activation Code(s) text box, and then click **Continue**. The Add License Administrator page opens. By default, your name is added as the License Administrator.

**Step 4** To allow additional people to receive information about future updates and serial number upgrades, enter their e-mail address in the space provided in the Add License Administrator page, and then click **Continue**.

The VMware Confirmation Page opens with the license key redemption information for the Activation Codes that you registered.

**Step 5** Save the product redemption information for your records, and then click **Continue**. The Link to Downloads and VMware's License Portal page opens thanking you for your registration.

After you finish the registration process, you receive an e-mail from VMware with information about the VMware license key or serial number.

---

**Note** We highly recommend that you write down the VMware license key and store it in a secure, easily accessible location.

---

**Step 6** To use Cisco SRE-V software, you must assign the VMware license key to the VMware vSphere Hypervisor™ host using the vSphere Client GUI as appropriate. See “Activating the VMware License Key” section on page 5-4.

---

**Related Topics**

- Cisco SRE-V Options, page 1-4
- VMware vSphere Hypervisor License Overview, page 5-1
- Activating the VMware License Key, page 5-4
- Accessing the VMware License Key Information, page 5-4
- Understanding Cisco SRE-V Options and Associated Tasks, page 1-8
Activating the VMware License Key

Before you begin activating the VMware license key, do the following:

- Download and install the vSphere Client. See Downloading and Installing the vSphere Client, page 6-1.

To activate the VMware license key, complete the following steps:

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>From the vSphere Client GUI, click the <strong>Configuration</strong> tab.</td>
</tr>
<tr>
<td>2</td>
<td>From the left pane, under Software, choose <strong>Licensed Features</strong>.</td>
</tr>
<tr>
<td>3</td>
<td>Click <strong>Edit...</strong>, which is located on the top right corner of the Licensed Features page. The Assign License page opens.</td>
</tr>
<tr>
<td>4</td>
<td>Choose <strong>Assign a New License to this Host</strong> radio button, and then click <strong>Enter Key</strong>. The Add License Key window opens.</td>
</tr>
<tr>
<td>5</td>
<td>Enter the license key in the New License Key field, and then click <strong>OK</strong>.</td>
</tr>
</tbody>
</table>

Related Topics

- Cisco SRE-V Options, page 1-4
- VMware vSphere Hypervisor License Overview, page 5-1
- Registering the VMware vSphere Hypervisor License, page 5-2
- Accessing the VMware License Key Information, page 5-4
- Understanding Cisco SRE-V Options and Associated Tasks, page 1-8

Accessing the VMware License Key Information

You can access the license key information from the vSphere Client GUI or the console interface.

**Note**

We highly recommend that you write down the VMware license key and store it in a secure, easily accessible location.

See the following sections for more information:

- Accessing the VMware License Key Information from the vSphere Client GUI, page 5-5
- Accessing the VMware License Key Information from the Console Interface, page 5-5
Accessing the VMware License Key Information from the vSphere Client GUI

To access the license key information from the vSphere Client GUI, complete the following steps:

**Step 1**  
From the vSphere Client GUI, choose a host.

**Step 2**  
Click the *Configuration* tab, and then choose *Licensed Features*.  
The license key information displays in the following format: XXXX-XXXX-XXXX-XXXX.

Accessing the VMware License Key Information from the Console Interface

The console interface allows you to access the VMware vSphere Hypervisor™ DCUI. To obtain the license key information from the console interface, choose *View Support Information*.  
The license key information displays in the following format: XXXX-XXXX-XXXX-XXXX.  
The physical machine serial number is also displayed. Make sure that you do not confuse the license key information with the physical machine serial number.
Managing Virtual Machines

Last Updated: August 4, 2011

A virtual machine is a software computer (just like a physical computer), which runs an operating system and applications. Virtual machines run on the VMware vSphere Hypervisor™. You can use the same VMware vSphere Hypervisor™ to run several virtual machines. Use the vSphere Client GUI to create and manage virtual machines. Use the vCenter Server to manage multiple VMware vSphere Hypervisor™ hosts.

This chapter contains the following section:

- Downloading and Installing the vSphere Client, page 6-1
- Downloading the vCenter Server, page 6-4
- Managing the Cisco SRE Service Module with vCenter, page 6-4
- Important Information About Creating Virtual Machines, page 6-5
- Information About vSwitches, page 6-7
- VMware vSphere Hypervisor Advanced Customization, page 6-7

Downloading and Installing the vSphere Client

To manage the virtual machine, you must download and install the vSphere Client.

The vSphere Client contains an online tutorial for first-time users. It also contains embedded in-line getting started assistance, which allows you to set up your virtual infrastructure through an easy to use, step-by-step process. If you are an experienced user, you can choose to turn-off the getting started in-line assistance.

**Note**
To download the vSphere Client, connection to the Internet is required. Before you download the vSphere client, verify that you have network connectivity.

To download and install the vSphere client, complete the following steps:

**Step 1**
Go to https://hypervisor-ip-address. You are directed to the VMware website and the Welcome page opens.

**Step 2**
Click Download vSphere Client, and then click Run to download the vSphere Client. The VMware vSphere Client is installed and a shortcut icon to the client appears on your desktop.
Step 3  Click the **VMware vSphere Client** icon to open the login window.

Step 4  To manage a single VMware vSphere Hypervisor™, enter the IP address or hostname of the VMware vSphere Hypervisor™ and the username and password, and then click **Login**. The vSphere Client GUI opens.

**Note**  If you are a first-time user of the VMware vSphere Hypervisor™, use **root** for the username; and for the password, leave the field empty. After you login, we recommend that you change the password.

**Note**  If you purchased the Cisco SRE-V Option 3 (Hardware, plus Virtualization software, plus Microsoft Windows software), a virtual machine is provided to you by default. For Cisco SRE-V options, see Figure 1-3.

Step 5  From the vSphere Client main page, do one of the following:

- To use the existing virtual machine that is provided to you by default with your Cisco SRE-V software Option 3, do the following:
  - From the left navigation tree, click the host name to expand it, and then choose the virtual machine.
  - Follow the instructions that are displayed in the right pane under the Getting Started tab. See Figure 6-1.

*Figure 6-1  vSphere Client Inventory Page with a Virtual Machine Selected*
• To create a new virtual machine, see the “Important Information About Creating Virtual Machines” section on page 6-5, and then do the following:
  – From the left navigation tree, choose the host name.
  – Follow the instructions that are displayed in the right pane under the Getting Started tab. See Figure 6-2.

![vSphere Client Inventory Page with the Host Name Selected](image)

**Figure 6-2 vSphere Client Inventory Page with the Host Name Selected**

**Note** If you are an experienced user, you can choose to remove the Getting Started tab from your view. Go to **Edit > Client Settings**. The General tab is selected by default. From the Tasks pane, uncheck the **Show Getting Started Tab** checkbox.

**Step 6** To manage the virtual machines, use the functionality provided by the vSphere Client:
- To access the online tutorial that is embedded in the vSphere Client GUI, click **Help > Tutorial**.
- To access the vSphere Client online help, click **Help > Help Topics**.

**Related Topics**
- Downloading the vCenter Server, page 6-4
- Managing the Cisco SRE Service Module with vCenter, page 6-4
- Important Information About Creating Virtual Machines, page 6-5
Downloading the vCenter Server

To manage multiple VMware vSphere Hypervisor™ hosts, download the vCenter Server.

Note

To download the vCenter Server, connection to the Internet is required. Before you download the vCenter Server, verify that you have network connectivity.

Before you begin, do the following:

- Make sure that you have downloaded and installed the vSphere Client. See “Downloading and Installing the vSphere Client” section on page 6-1.

To download the vCenter Server, complete the following steps:

Step 1  Go to https://hypervisor-ip-address. You are directed to the VMware website and the Welcome page opens.

Step 2  Click Download VMware vCenter.

For information on the vCenter Server, see the ESXi Embedded and vCenter Server Setup Guide at:

Related Topic

- Managing the Cisco SRE Service Module with vCenter, page 6-4

Managing the Cisco SRE Service Module with vCenter

Before you begin, do the following:

- Make sure that you have downloaded and installed the vSphere Client. See “Downloading and Installing the vSphere Client” section on page 6-1.

- Make sure that you have downloaded and vCenter Server. See “Downloading the vCenter Server” section on page 6-4.

To manage the Cisco SRE Service Module with vCenter, complete the following steps:

Step 1  Click the VMware vSphere Client icon to open the login window.

Step 2  To manage multiple hosts, enter the IP address or hostname of the vCenter Server, and the username and password of the vCenter Server, and then click Login. The vSphere Client GUI opens.

Step 3  From the vSphere Client main page, do the following:

a. Create a datastore.

b. Add a VMware vSphere Hypervisor™ host. The Add Host Wizard page opens.

c. Provide the IP address, and the username and password of the VMware vSphere Hypervisor™ host.

For details, see the ESXi Embedded and vCenter Server Setup Guide at:
Important Information About Creating Virtual Machines

If you purchased the Cisco SRE-V Option 3 (Hardware, plus Virtualization software, plus Microsoft Windows software), a virtual machine with VMware tools and datastore(s) is provided to you by default. You can create additional virtual machines if needed.

If you purchased the Cisco SRE-V Option 1 (Hardware only, without the Virtualization or Microsoft Windows software) or Option 2 (Hardware plus Virtualization software), you must create virtual machines.

For Cisco SRE-V options, see Figure 1-3.

See the following sections:
- Basic Workflow for Creating Virtual Machines, page 6-5
- Limitations for Creating Virtual Machines, page 6-5
- Networking Prerequisites for Creating Virtual Machines, page 6-6
- Installing VMware Tools, page 6-6

Basic Workflow for Creating Virtual Machines

1. (Optional) Create a datastore in Cisco SRE-V.
2. Create the virtual machine.
3. Install the operating system on the virtual machine.
4. Configure networking (external) for a virtual machine.
5. Configure networking (internal) for a virtual machine.

For instructions, see the vSphere Client online help.

Limitations for Creating Virtual Machines

Before creating virtual machines, note the following limitations:
- Each virtual machine has its own resource limitations, such as CPU core number and memory size.
- Virtual Symmetric Multiprocessing (vSMP) is not supported.
- Physical peripheral devices, such as serial port is not supported.
- The physical USB device, which is plugged into the USB port in the front panel of the Cisco SRE Service Module, must not exceed 500 mA (2.5 Watt). For information about assigning USB devices to a virtual machine, see the vSphere user guide.

Related Topic
- Downloading and Installing the vSphere Client, page 6-1
Important Information About Creating Virtual Machines

If you want to assign virtual machines on different VLANs, you must configure VLANs on the ISR G2.

Example

interface SM1/1
description Internal switch interface connected to Service Module
switchport mode trunk
!
interface Vlan50
ip address 50.50.50.5 255.255.255.0
!
interface Vlan60
ip address 60.60.60.6 255.255.255.0

Related Topic
- Downloading and Installing the vSphere Client, page 6-1

Installing VMware Tools

VMware Tools are a suite of utilities that enhances the performance of the virtual machine’s guest operating system and improves the management of the virtual machine.

If you purchased the Cisco SRE-V Option 3 (Hardware, plus Virtualization software, plus Microsoft Windows software), a virtual machine with VMware tools is provided to you by default so you do not need to install VMware tools on that machine. But, if you create a new virtual machine, you must install VMware tools on that virtual machine.

If you purchased the Cisco SRE-V Option 1 (Hardware only, without the Virtualization or Microsoft Windows software) or Option 2 (Hardware plus Virtualization software), you must install VMware tools after you create the virtual machine.

For Cisco SRE-V options, see Figure 1-3.

Note

Before you install VMware tools, make sure that you have installed the supported guest operating system on the virtual machine.

To install VMware tools on a virtual machine, complete the following steps:

Step 1 Go to the vSphere Client GUI main page.
Step 2 From the left navigation tree, click the host name to expand it.
Step 3 Right-click the virtual machine in which you want to install VMware tools, and then choose Power > Power On.
Step 4 Click the Console tab to make sure that the guest operating system starts successfully, and log in if necessary.
Step 5 Right-click the virtual machine in which you want to install VMware tools, choose Guest, and then choose Install/Upgrade VMware Tools. The Install VMware Tools confirmation dialog box opens.
Step 6 Click Ok in the confirmation dialog box.
Step 7 Log into the virtual machine.
Step 8 Go to Start > Open Windows Explorer.
Step 9 Under Computer, click on the VMware Tools folder, and then choose VMware Tools or VMware Tools 64 as appropriate. The VMware Installation Wizard opens.
Step 10 Follow the steps in the wizard to complete the installation.
Step 11 Click Finish.
Step 12 Choose Yes when prompted to restart your system.
Step 13 To verify the VMware tools installation status, click the Summary tab in the vSphere Client GUI. You should see VM Tools - Status OK.

For more information, see The VMware Tools Installation Guide For Operating System Specific Packages document.

Related Topic
- Downloading and Installing the vSphere Client, page 6-1

Information About vSwitches

The system creates the following vSwitches in the VMware vSphere Hypervisor™:

- **vSwitch0**—Uses the PCIe interface to connect to the VMware vSphere Hypervisor™. The PCIe interface is sm slot/0.
  vSwitch0 contains the VMkernel port group for the Management Network. The Management Network is used by the vSphere client to connect to the VMware vSphere Hypervisor™.

  **Note** For the Cisco IOS service-module commands to take effect, make sure that the Management Network VMkernel port group is configured to use the vSwitch that has the PCIe interface as the uplink. We recommend that you do not change the default VMkernel port group name, which is Management Network.

- **vSwitch1**—By default, vSwitch1 is connected to the MGF interface of the Cisco SRE Service Module. The MGF interface is sm slot/1.
  vSwitch1 contains the VM Network port group, which can be used by guest virtual machines.

VMware vSphere Hypervisor Advanced Customization

For important information about advanced customization of the VMware vSphere Hypervisor™, see the following sections:

- Network Analysis Module Support, page 6-8
- Console Takes a Long Time to Reboot After Resetting System Configuration, page 6-8
- Cannot Change the VMware vSphere Hypervisor IP Address from the vSphere Console Interface, page 6-8
- Changing the IP Address of the VMware vSphere Hypervisor’s Management Network, page 6-9
Network Analysis Module Support

By default, the Network Analysis Module (NAM) capability is enabled on Cisco SRE-V. Only one NAM capable service module is supported in a ISR G2. Therefore, if the ISR G2 contains more than one NAM, make sure that you keep one NAM enabled, and disable the rest of the NAMs.

- To disable a NAM, use the following command from tech-support:
  
  ```bash
  # esxcfg-advcfg --user-var CiscoRBCPNAMCapable --set-user-var 0
  ```

- To enable a NAM, use the following command from tech-support:
  
  ```bash
  # esxcfg-advcfg --user-var CiscoRBCPNAMCapable --set-user-var 1
  ```

Reboot the Cisco SRE Service Module for the change to take effect.

Console Takes a Long Time to Reboot After Resetting System Configuration

When you choose the Reset System Configuration option from the vsphere console interface, the console reboots after a time interval of approximately 2 minutes. This is expected behavior.

Cannot Change the VMware vsphere Hypervisor IP Address from the vsphere Console Interface

When you use the vsphere console interface to change the IP address of the VMware vsphere Hypervisor™, that IP address change is temporary and does not appear after you reboot the Cisco SRE Service Module. When you reboot the Cisco SRE Service Module, you notice that the IP address that you had configured using the following Cisco IOS command is in effect:

```
service-module ip address hypervisor-ip-address subnet-mask
```

If you want to change the IP address of the VMware vsphere Hypervisor™, see the “Changing the IP Address of the VMware vsphere Hypervisor’s Management Network” section on page 6-9.
Changing the IP Address of the VMware vSphere Hypervisor’s Management Network

To change the IP address of the VMware vSphere Hypervisor™, do the following:

1. Enter interface configuration mode for the slot and port where the Cisco SRE Service Module resides. For example:
   
   ```
   Router(config)# interface sm 1/0
   Router(config-if)#
   ```

2. Enter the following commands:
   
   ```
   Router(config-if)# service-module heartbeat-reset disable
   Router(config-if)# no service-module ip default-gateway hypervisor-gateway-ip-address
   Router(config-if)# no service-module ip address hypervisor-ip-address subnet-mask
   ```

3. Use the vSphere console interface to change the IP address of the VMware vSphere Hypervisor™.

Changing the Management Network Link

From the vSphere client, go to Home > Inventory > Configuration > Networking. Notice that under Virtual Network: vswitch0, the Management Network is connected to the Physical Adapter vmnic1, which is the PCIe link. To change this link, for example, from vmnic1 to vmic0, do the following:

1. Enter interface configuration mode for the slot and port where the Cisco SRE Service Module resides. For example:
   
   ```
   Router(config)# interface sm 1/0
   Router(config-if)#
   ```

2. Enter the following commands:
   
   ```
   Router(config-if)# service-module heartbeat-reset disable
   Router(config-if)# no service-module ip default-gateway hypervisor-gateway-ip-address
   Router(config-if)# no service-module ip address hypervisor-ip-address subnet-mask
   ```

Modifying Access to the DCUI

The value for the VMkernel.Boot.tty2Port is com1. Do not change this value.

Cisco IOS uses the com1 serial port to session into the console interface. The console interface allows you to access the VMware vSphere Hypervisor™ DCUI to perform Cisco SRE-V configuration. If you try to change the com1 port value from Advanced Settings in the vSphere Client GUI, you will not be able to access the Cisco SRE Service Module. To access the Cisco SRE Service Module, you must reinstall Cisco SRE-V.
VMware vSphere Hypervisor Does Not Remain in a Shutdown State

VMware vSphere Hypervisor™ cannot remain in a shutdown state, unless you disable heartbeat reset.

To disable heartbeat reset, do the following:

1. Enter interface configuration mode for the slot and port where the Cisco SRE Service Module resides. For example:
   
   ```
   Router(config)# interface sm 1/0  
   Router(config-if)#
   ```

2. Enter the `service-module heartbeat-reset disable` command to disable heartbeat-reset:
   
   ```
   Router(config-if)# service-module heartbeat-reset disable
   ```

Adding the Virtual Machines in the Same Subnet as the VMware vSphere Hypervisor

To add virtual machines in the same subnet as the VMware vSphere Hypervisor™, complete the following steps:

**PREREQUISITES**

See the “Prerequisites for Configuring the Cisco SRE Service Module Interfaces” section on page 3-3.

**SUMMARY STEPS**

From the Host-Router CLI, enter:

1. `enable`
2. `configure terminal`

Configure VLANs

1. `interface vlan vlan_number`
2. `ip address vlan-ip-address subnet mask`
3. `no shut`
4. `end`

Configure slot/0 of the VMware vSphere Hypervisor™

1. `interface sm slot/0`
2. `ip unnumbered vlan vlan_number`
3. `service-module ip address hypervisor-ip-address subnet-mask`
4. `service-module ip default-gateway hypervisor-gateway-ip-address`
5. `no shut`
6. `exit`
7. `ip route hypervisor-ip-address subnet-mask sm slot/0`
**Configure slot/1 of the VMware vSphere Hypervisor™**

1. `interface sm slot/1`
2. `switchport mode trunk`
3. `[switchport trunk allowed vlan vlan_numbers]`
4. `exit`

**Save Configuration**

1. `copy running-config startup-config`
2. `show running-config`

### DETAILED STEPS

<table>
<thead>
<tr>
<th>Command or Action</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>From the Host-Router CLI</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Step 1</strong> enable</td>
<td>Enters privileged EXEC mode on the host router. Enter your password if prompted.</td>
</tr>
<tr>
<td>Example: Router&gt; enable Router&gt; &lt;password&gt; Router#</td>
<td></td>
</tr>
<tr>
<td><strong>Step 2</strong> configure terminal</td>
<td>Enters global configuration mode on the host router.</td>
</tr>
<tr>
<td>Example: Router&gt; configure terminal</td>
<td></td>
</tr>
<tr>
<td><strong>Configure VLANs</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Step 1</strong> interface vlan vlan_number</td>
<td>Enters VLAN configuration mode for the specified VLAN number.</td>
</tr>
<tr>
<td>Example: Router(config)# interface vlan1</td>
<td></td>
</tr>
<tr>
<td><strong>Step 2</strong> ip address vlan-ip-address subnet-mask</td>
<td>Specifies the IP address for the VLAN.</td>
</tr>
<tr>
<td>Example: Router(config-if)# ip address 10.0.0.100 255.255.255.0</td>
<td>- <code>$vlan-ip-address</code>—IP address for the VLAN.</td>
</tr>
<tr>
<td></td>
<td>- <code>$subnet-mask</code>—Subnet mask to append to the IP address.</td>
</tr>
<tr>
<td><strong>Step 3</strong> no shut</td>
<td>Causes the interface to be administratively up.</td>
</tr>
<tr>
<td>Example: Router(config-if)# no shut</td>
<td></td>
</tr>
<tr>
<td><strong>Step 4</strong> end</td>
<td>Returns to global configuration mode on the host router.</td>
</tr>
<tr>
<td>Example: Router(config)# end</td>
<td></td>
</tr>
</tbody>
</table>
### Command or Action

<table>
<thead>
<tr>
<th>Command or Action</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configure <code>slot/0</code> of the VMware vSphere Hypervisor™</td>
<td>Enters interface configuration mode for the slot and port where the Cisco SRE Service Module resides.</td>
</tr>
</tbody>
</table>

#### Step 1

**interface sm slot/0**

**Example:**

```
Router(config)# interface sm 1/0
```

#### Step 2

**ip unnumbered vlan vlan_number**

**Example:**

```
Router(config-if)# ip unnumbered vlan1
```

- The ip unnumbered command enables IP processing on the specified VLAN interface without assigning an explicit IP address to that interface.
  - *vlan_number*—Number of the VLAN interface on which the router has an assigned IP address.

**Note** The unnumbered interface must be unique. It cannot be another unnumbered interface. The `ip unnumbered` command creates a point-to-point interface between devices. Broadcasting is not supported.

#### Step 3

**service-module ip address hypervisor-ip-address subnet-mask**

**Example:**

```
Router(config-if)# service-module ip address 10.0.0.1 255.255.255.0
```

- Specifies the IP address of the VMware vSphere Hypervisor™.
  - *hypervisor-ip-address*—IP address of the VMware vSphere Hypervisor™. See Figure 3-2.
  - *subnet-mask*—Subnet mask to append to the IP address; must be in the same subnet as the host router.

#### Step 4

**service-module ip default-gateway hypervisor-gateway-ip-address**

**Example:**

```
Router(config-if)# service-module ip default-gateway 10.0.0.100
```

- Specifies the IP address of the default gateway for the VMware vSphere Hypervisor™.
  - *hypervisor-gateway-ip-address*—IP address for the default gateway router.

#### Step 5

**no shut**

**Example:**

```
Router(config-if)# no shut
```

- Causes the interface to be administratively up.

#### Step 6

**exit**

**Example:**

```
Router(config)# exit
```

- Returns to global configuration mode on the host router.

#### Step 7

**ip route hypervisor-ip-address subnet-mask sm slot/0**

**Example:**

```
Router(config)# ip route 10.0.0.1 255.255.255.255 SM1/0
```

- Creates a static route.
  - If you used the `ip unnumbered` command in Step 2, you must use the `ip route hypervisor-ip-address subnet-mask sm slot/0` command to create a static route.
  - *hypervisor-ip-address subnet-mask*—IP address and subnet mask of the VMware vSphere Hypervisor™.
  - *slot/0*—Slot and port where the Cisco SRE Service Module resides.
### Command or Action

**Configure slot/1 of the VMware vSphere Hypervisor**

<table>
<thead>
<tr>
<th>Step</th>
<th>Command or Action</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Step 1</strong></td>
<td><code>interface sm slot/1</code></td>
<td>Enters interface configuration mode for the slot and port where the Cisco SRE Service Module resides.</td>
</tr>
<tr>
<td></td>
<td><strong>Example:</strong></td>
<td>Router(config)# interface sm 1/1</td>
</tr>
<tr>
<td><strong>Step 2</strong></td>
<td><code>switchport mode trunk</code></td>
<td>Puts the port into permanent trunking mode. The default configuration is access mode.</td>
</tr>
<tr>
<td></td>
<td><strong>Example:</strong></td>
<td>Router(config-if)# switchport mode trunk</td>
</tr>
<tr>
<td><strong>Step 3</strong></td>
<td><code>[switchport trunk allowed vlan vlan_numbers]</code></td>
<td>(Optional) Allows trunking on the specified VLANs.</td>
</tr>
<tr>
<td></td>
<td><strong>Example:</strong></td>
<td>Router(config-if)# switchport mode trunk&lt;br&gt;Router(config-if)# switchport trunk allowed vlan 1-2,40,60,1002-1005</td>
</tr>
<tr>
<td><strong>Step 4</strong></td>
<td><code>exit</code></td>
<td>Returns to global configuration mode on the host router.</td>
</tr>
<tr>
<td></td>
<td><strong>Example:</strong></td>
<td>Router(config)# exit</td>
</tr>
</tbody>
</table>

### Save Configuration

**Step 1**

`copy running-config startup-config`

**Example:**

Router# copy running-config startup-config

**Step 2**

`show running-config`

**Example:**

Router# show running-config

---

**VMware vSphere Hypervisor Advanced Customization**

Chapter 6  Managing Virtual Machines
Managing RAID

Last Updated: August 4, 2011

This chapter provides information about managing Redundant Array of Inexpensive Disks (RAID). It contains the following sections:

- Entering the RAID Management Command Environment, page 7-1
- Hot-Swapping the Faulty RAID 1 Disk Drive, page 7-3
- Commands for Managing RAID, page 7-4
- Troubleshooting RAID, page 7-8

Entering the RAID Management Command Environment

To add or modify RAID configuration, you must enter the RAID management command environment.

<table>
<thead>
<tr>
<th>Note</th>
</tr>
</thead>
<tbody>
<tr>
<td>The RAID management CLI is different from the Cisco IOS CLI. For a list of frequently used commands that you can use to manage RAID, see the “Commands for Managing RAID” section on page 4.</td>
</tr>
</tbody>
</table>

Before you begin, do the following:

- Shutdown all virtual machines.
- Backup the datastore.
- Enable Remote Tech Support (SSH) through the VMware vSphere Hypervisor™ DCUI or the vSphere Client.
To enter the RAID management command environment, complete the following steps:

**Step 1** Use the SSH Client software to log into the VMware vSphere Hypervisor™. Do the following:

a. For the hostname, enter the IP address of the VMware vSphere Hypervisor™ or the DNS hostname.

b. If prompted to accept the server’s host key, click Yes.

c. Use root for the username.

d. When prompted for a password, do the following:
   
   – If you are a first time user, leave the password empty by pressing Enter.
   
   – If you have configured a password, enter that password, and then press Enter.

The following Tech Support Shell prompt appears:

~ #

**Step 2** At the Tech Support Shell prompt, use the promise-raid-cli command, and then press Enter. You enter the RAID management command environment:

~ # promise-raid-cli

raid-cli>

**Step 3** Use the appropriate RAID management command(s) as shown in the following example:

raid-cli> logdrv

For a list of frequently used commands that you can use to manage RAID, see the “Commands for Managing RAID” section on page 7-4.

**Step 4** Use the exit command to exit from the RAID management command environment:

raid-cli> exit

~ #

**Step 5** Use the exit command to exit from the Tech Support Shell:

~ # exit

**Related Topics**

- Understanding RAID Options, page 4-1
- Commands for Managing RAID, page 7-4
- Determining the Location of the Physical SATA Drive, page 7-4
Hot-Swapping the Faulty RAID 1 Disk Drive

**Note**

Hot-Swapping is supported in RAID 1 mode only.

If you chose the RAID 1 option during installation, and one of the disk drive fails, you can replace that faulty disk drive with a new disk drive.

To hot-swap the faulty RAID 1 disk drive, complete the following steps:

**Step 1**
Determine the location of the faulty disk drive. See the “Determining the Location of the Physical SATA Drive” section on page 7-4.

**Step 2**
Remove the faulty disk drive.

**Step 3**
Insert a new disk drive. The rebuild process starts automatically on the new disk drive.

The rebuild process might take approximately two hours to complete. You can continue to perform normal system operations during the rebuild process.

**Caution**

Make sure that you do not unplug the functional disc drive during the rebuild process. If you do, you will lose data.

If the rebuild process does not start, see the “Rebuild Process Does Not Start” section on page 7-9 to resolve the problem.

**Step 4**
(Optional) To check the rebuild status, use the `rb -a list` command from the RAID management command environment, as shown in the following example:

```
raid-cli> rb -a list
Rebuild is in progress 10% in logical drive with ID 0 on controller #0!
```

You can also check the rebuild status in syslog.

**Related Topics**

- Understanding RAID Options, page 4-1
- Entering the RAID Management Command Environment, page 7-1
- Rebuild Process Does Not Start, page 7-9
Determining the Location of the Physical SATA Drive

To determine the location of the physical SATA drive, complete the following steps:

### Step 1
From the vSphere Client GUI Home page, do the following:

a. Choose **Inventory > Configuration**.

b. From the Hardware pane (left pane), choose **Storage**.

c. From the right pane, click the **Datastores** button.

d. Right-click a datastore, and then choose **Properties**. The Properties dialog box opens.

e. From the Properties dialog box, click the **Manage Paths...** button. From the Paths pane, look at the Runtime Name column. The Runtime Name column provides information about the location of datastore1 as shown in the following example:

```
vmhba0:C0:T1:L0
```

where T1 is the location of the datastore. T is the SCSI target and 1 is the ID number of JBOD volume where the datastore is located. T1 maps to the JBOD volume ID 1 in **Step 2**.

### Step 2
From the RAID management command environment, use the **logdrv** command, as shown in the following example:

```
raid-cli> logdrv
ID RAID Disks Stripe Size(MB) DiskID Name
0 JBOD 1 N/A 476940.02 (1) JBOD on port 01 (00)
1 JBOD 1 N/A 476940.02 (2) JBOD on port 02 (00)
```

T1 from **Step 1** maps to the JBOD logical volume 1 (ID column). This JBOD logical volume 1 (ID column) is built on top of the physical SATA drive 2 (DiskID column). DiskID 2 indicates that it is the second physical SATA drive.

**Note**
The DiskID number that is displayed from the RAID management CLI output does not match with the Disk number that is displayed on the front panel of the Cisco SRE Service Module:

- Disk 0 on the front panel of the Cisco SRE Service Module is represented as DiskID 1 in the RAID management CLI output.
- Disk 1 on the front panel of the Cisco SRE Service Module is represented as DiskID 2 in the RAID management CLI output.

### Commands for Managing RAID

You can use the RAID management CLI to add or modify RAID configuration, to view RAID status, and to migrate between RAID levels.

**Note**
The RAID management CLI is different from the Cisco IOS CLI.
Table 7-1 provides a list of frequently used commands that you can use to manage RAID. A comprehensive list of all of the RAID Management commands is available online. You can either use the `help` command to access all of the RAID commands, or you can prepend a command with `help` to display details about that command. For example, the `help logdrv` command provides the syntax and options for the logdrv command.

<table>
<thead>
<tr>
<th>Command or Action</th>
<th>Purpose</th>
<th>Note</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>phydrv -a list</strong></td>
<td>Displays information about physical drives.</td>
<td>The DiskID number that is displayed from the RAID management CLI output does not match with the Disk number that is displayed on the front panel of the Cisco SRE Service Module:</td>
</tr>
<tr>
<td>or</td>
<td></td>
<td>– Disk 0 on the front panel of the Cisco SRE Service Module is represented as DiskID 1 in the RAID management CLI output.</td>
</tr>
<tr>
<td><strong>logdrv -a list</strong></td>
<td>Displays information about logical RAID volumes.</td>
<td>The DiskID number that is displayed from the RAID management CLI output does not match with the Disk number that is displayed on the front panel of the Cisco SRE Service Module:</td>
</tr>
<tr>
<td>or</td>
<td></td>
<td>– Disk 0 on the front panel of the Cisco SRE Service Module is represented as DiskID 1 in the RAID management CLI output.</td>
</tr>
<tr>
<td><strong>logdrv -a clear -i 0</strong></td>
<td>Removes all of the logical volumes from the system.</td>
<td></td>
</tr>
</tbody>
</table>
### Table 7-1 RAID Management Commands (continued)

<table>
<thead>
<tr>
<th>Command or Action</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>logdrv -a del -i 0 -l 1</code> or <code>logdrv -a del -l 1</code></td>
<td>Removes the second logical volume. Note: The logical volume ID can start with 0.</td>
</tr>
<tr>
<td><strong>Example:</strong> <code>raid-cli&gt; logdrv -a del -i 0 -l 1</code></td>
<td></td>
</tr>
<tr>
<td><strong>Example:</strong> <code>logdrv -a add -p 1,2 -e 0,0 -z &quot;raid=raid0,name=RAID0,init=quick&quot;</code></td>
<td>Creates a simple block level striping RAID 0 volume using the full capacity (single full extent on each of the drives) across both first and second SATA drives. <code>-z</code> can be used to change stripe block size. Note: Cisco SRE-V supports a maximum of two logical volumes.</td>
</tr>
<tr>
<td><strong>Example:</strong> <code>raid-cli&gt; logdrv -a add -i 0 -p 1,2 -e 0,0 -z &quot;name=RAID1,raid=raid1&quot;</code></td>
<td>Creates a simple 1:1 mirrored RAID 1 volume using the full capacity on both SATA drives. Note: You can create a maximum of two logical volumes.</td>
</tr>
<tr>
<td><code>logdrv -a add -i 0 -p 1,2 -z &quot;raid=JBOD,init=quick&quot;</code></td>
<td>Removes the RAID metadata on both SATA drives and makes them non-RAID drives. If a datastore is not created on top of the JBOD volume, that JBOD volume might disappear after reboot.</td>
</tr>
</tbody>
</table>
### Table 7-1  RAID Management Commands (continued)

<table>
<thead>
<tr>
<th>Command or Action</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>logdrv -a list -v</code></td>
<td>Displays details about the RAID configuration.</td>
</tr>
<tr>
<td>or <code>logdrv -v</code></td>
<td></td>
</tr>
</tbody>
</table>

**Example:**

```
raido-cli> logdrv -a list -v
Array ID : 0
Array name : RAID0
Array size : 953752.00 MB
Array stripe size in number of blocks : 64
Array sector size : 512
Array raid mode : RAID0
Array write cache mode : Write Through
Number of disks in array : 2
Disk members with ID in array : (1,2)
Array activity status : Idle
Array functional status : Online
Driver Cache Mode: Write Thru
Driver Lookahead threshold: 0
Driver Consolidation: enabled
```

**Table 7-1 RAID Management Commands (continued)**

<table>
<thead>
<tr>
<th>Command or Action</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>event -a list -v -c 10</code></td>
<td>Displays the oldest 10 events (if available) from the event queue.</td>
</tr>
</tbody>
</table>

**Example:**

```
raido-cli> event -a list -v -c 10
Time: Jan 29, 2011 06:19:00
EventID: 0x90001
Event Description: Logical drive "RAID0" deleted
```

**Related Topics**

- Understanding RAID Options, page 4-1
- Entering the RAID Management Command Environment, page 7-1
Troubleshooting RAID

This section contains the following:

- Cannot View Datastores, page 7-8
- Rebuild Process Does Not Start, page 7-9

Cannot View Datastores

Problem
After disk migration, reboot, or Cisco SRE-V software upgrade, you are unable to view the datastores in Inventory > Configuration > Storage.

Solution
To resolve this problem, do the following:

1. Rescan the system a couple of times. From the vSphere Client GUI Home page, do the following:
   a. Choose Inventory > Configuration.
   b. From the Hardware pane (left pane), choose Storage.
   c. From the Datastores pane (right pane), choose Rescan All... (located on the upper right corner). The Rescan dialog box opens.
   d. Click OK.

2. If rescanning the system does not resolve the problem, do the following:
   a. Choose Inventory > Configuration.
   b. From the Hardware pane (left pane), choose Storage.
   c. Click the Add Storage... button. The Select Storage Type wizard page opens.
   d. From the right pane, choose Disk/LUN, and then click Next. The Select Disk/LUN wizard page opens.
   e. From the right pane, choose a disk, and then click Next. The Select VMFS Mount Options wizard page opens.
   f. From the right pane, choose the Assign a New Signature radio button, and then click Next.
   g. Choose Free Space, and then click Finish.

   The missing datastores display with a modified name, which you can change. For example, Datastore_R0 displays as snap-XXXXX-datastore_R0; and datastore_R1 displays as snap-XXXXX-datastore_R1. To change the name of the datastore, right-click the appropriate datastore, and the choose Rename.

Related Topics
- Upgrading the Cisco SRE-V Software, page 4-10
Rebuild Process Does Not Start

Problem
After hot-swapping the faulty RAID 1 disk drive, the rebuild process does not start.

Probable Cause
RAID configuration shows a new JBOD logical volume, which you must delete.

Solution
To resolve this problem, do the following:

1. From the RAID management CLI, use the `logdrv` command to view RAID configuration.
   When the valid partition table appears on the newly inserted drive, you might notice that the RAID configuration is unbalanced, as shown in the following example:

   ```
   raid-cli> logdrv
   ID  RAID  Disks  Sectors  Size(MB)  DiskID Name
   0  RAID1  2      64       476876.00 (-,2) RAID1
   1  JBOD   1      64       476940.02 (1) JBOD on port 01 (00)
   ```
   
   where (-,2) RAID1 represents an unbalanced array; and ID 1 shows a new JBOD logical volume. JBOD represents non-RAID, which you must delete.

2. Use the `logdrv -a del -l <ID number of the JBOD>` command to delete the JBOD logical volume:
   ```
   raid-cli> logdrv -a del -l 1
   ```
   
   Note: -l in the command is lower case “L” and stands for logical.

   After the JBOD logical volume is deleted, the rebuild process starts automatically on the new disk drive.
   
   The rebuild process might take approximately two hours to complete. You can continue to perform normal system operations during the rebuild process.

   Caution: Do not unplug the functional disk drive during the rebuild process. If you do, you will lose data.

3. (Optional) To check the rebuild status, use the `rb -a list` command, as shown in the following example:
   ```
   raid-cli> rb -a list
   Rebuild is in progress 10% in logical drive with ID 0 on controller #0!
   ```
   
   You can also check the rebuild status in syslog.

Related Topic
- Hot-Swapping the Faulty RAID 1 Disk Drive, page 7-3
Recovering from Device or Software Failure

Last Updated: August 4, 2011

This chapter provides information about recovering from a device or software failure. It contains the following sections:

- Transferring Licenses from a Defective Device to an RMA Device, page 8-1
- Recovering from a Microsoft Windows Software Failure, page 8-3

Transferring Licenses from a Defective Device to an RMA Device

If the service module is defective, contact TAC to obtain a Return Merchandise Authorization (RMA) service module. A blank RMA service module is shipped to you. After you receive the RMA service module, you must transfer and activate the VMware vSphere Hypervisor™ license and the Microsoft Windows license (if applicable) from the defective device onto the RMA service module.

Before you begin, make sure that you have the following:

- The VMware license key or serial number that was used to activate the VMware vSphere Hypervisor™ license on the defective service module. See “Accessing the VMware License Key Information” section on page 5-4.
- The Virtual Key that was used to activate the Microsoft Windows license on the defective service module—Applicable if you purchased Cisco SRE-V Option 3 (Hardware, plus Virtualization software, plus Microsoft Windows software).

The Virtual Key is on the Microsoft Windows Certificate of Authenticity (COA) label, which is located at the bottom of the defective service module. The COA label contains two sets of keys: Physical Key and Virtual Key. Make a note of the Virtual Key because this is the key that you will need to transfer onto the RMA device. See Figure 8-1.

**Note** Before you send the defective service module to Cisco Systems, make sure that you retain a copy of the original COA label. After you return the service module, Cisco Systems cannot retrieve the COA label from the returned service module.
Figure 8-1 shows the COA label.

**Figure 8-1  COA Label**

To transfer and activate the VMware vSphere Hypervisor™ license and the Microsoft Windows license from the defective service module onto an RMA service module, complete the following steps:

**Step 1** Install the RMA service module into the router. See Chapter 2, “Installing the Cisco SRE Service Module into the Router.”

**Step 2** If you have not configured the Cisco SRE Service Module interfaces, configure them. See Chapter 3, “Configuring the Cisco SRE Service Module Interfaces.”

**Step 3** Download and install the Cisco SRE-V software on the Cisco SRE Service Module. See Chapter 4, “Installing and Managing the Cisco SRE-V Software.”

**Step 4** Transfer the VMware vSphere Hypervisor™ license from the defective device onto the RMA device. Use the same license key that you had used to activate the VMware vSphere Hypervisor™ license on the defective device. See “Accessing the VMware License Key Information” section on page 5-4.

**Step 5** If you have not installed the vSphere Client, install it. See Chapter 6, “Managing Virtual Machines.”

**Step 6** If you purchased the Cisco SRE-V Option 3 (Hardware, plus Virtualization software, plus Microsoft Windows software), install the Microsoft Windows software using the Microsoft Windows Server 2008 recovery DVD. Do the following.

a. Use the vSphere Client GUI to install the Microsoft Windows software. See Recovering from a Microsoft Windows Software Failure, page 8-3.

b. Transfer and activate the Microsoft Windows license onto the virtual machine. Access the virtual machine console from the vSphere Client, and then enter the Virtual Key in the Product Key field. See Figure 8-1.

c. Follow the instructions provided in vSphere Client to continue with the Activation process.

**Step 7** If you purchased the Cisco SRE-V Option 1 (Hardware only) or Option 2 (Hardware plus Virtualization software), install your own version of the Microsoft Windows Server 2003 or Microsoft Windows Server 2008 software, and then activate the software license.
Recovering from a Microsoft Windows Software Failure

If the Microsoft Windows software gets corrupted or accidentally deleted from your system, reinstall Microsoft Windows by using the Microsoft Windows Server 2008 recovery DVD, which you received when you purchased the Cisco SRE-V Option 3 (Hardware, plus Virtualization software, plus Microsoft Windows software). For Cisco SRE-V options, see Figure 1-3.

To recover from a Microsoft Windows software failure, complete the following steps:

Step 1 If the Microsoft Windows software gets corrupted, delete it from your system.
Step 2 Install Microsoft Windows Server 2008 from the recovery DVD. After Microsoft Windows 2008 Server is installed, a virtual machine is created.
Step 3 Click the VMware vsphere Client icon on your desktop to open the login window.
Step 4 Enter the IP address or hostname of the VMware vsphere Hypervisor™ and the username and password, and then click Login. The vsphere Client GUI opens.
Step 5 Choose File > Deploy OVF Template... The Deploy OVF Template wizard opens.
Step 6 Choose the Deploy from File radio button.
Step 7 Enter the location of the recovery DVD in the field provided, or click Browse..., and then navigate to the location where you copied the contents of the recovery DVD.
Step 8 Click Next >. The OVF Template Details page opens, which summarizes the information about the OVF template.
Step 9 Verify the details, and then click Next >. The End User License Agreement Page opens.
Step 10 Click Accept if you agree with the terms and conditions, and then click Next >. The Name and Location page opens.
Step 11 Enter a unique name for the deployed OVF template, and then select the folder location within the inventory where the OVF template must reside.
   The name can contain a maximum of 80 characters. It must be unique within the virtual machine folder. The name is case sensitive.
Step 12 Click Next >. The Network Mapping page opens.
Step 13 Specify the networks that must use the deployed OVF template. To change the destination network, click the network listed in the Destination Network column, and then choose a network from the drop-down list.
Step 14 Click Next >. The Ready to Complete page opens where you can verify the OVF template's configuration.
Step 15 Click Finish.

Related Topic
- Transferring Licenses from a Defective Device to an RMA Device, page 8-1
INDEX

A

audience i-v

B

basic workflow
Cisco SRE-V 1-7
configuring Cisco SRE service module interfaces 3-1
creating virtual machines 6-5
installing Cisco SRE service module in router 2-1

C

Cisco applications
installing 4-11
Cisco IOS CLI 1-7
Cisco IOS layer 3 routed configuration options
devices in different branch subnets 3-11
devices in the same branch subnet 3-16
Cisco IOS software 1-7
Cisco SRE service module interfaces
basic workflow 3-1
Cisco IOS layer 3 routed configuration 3-11
configuring 3-2, 3-3
external interface configuration 3-23
IP address location i-ix, 3-5
MGF layer 2 switched configuration 3-4
overview 3-2
prerequisites 3-3
Cisco SRE-V
basic workflow 1-7
feature licenses 1-6
hardware requirements 1-3
managing 1-7
overview 1-1
software options 1-4
software requirements 1-4
terms 1-2
understanding options 1-8
Cisco SRE-V and Standalone VMware, difference 1-3
Cisco SRE-V software
downgrading 4-10
downloading 4-4
installing 4-5
uninstalling 4-8
upgrading 4-10
verify installation 4-9
verify uninstallation 4-9
CLI
Cisco IOS 1-7
RAID 1-7
COA label 8-1
command
reload 3-24
reset 3-24
shut down 3-24
console interface 3-2
conventions i-v
conventions, typographical i-v

D

DCUI 3-2, 4-7
enter and exit 4-7
modifying access 6-9
documentation
  audience i-v
  conventions i-v
  obtaining i-vi
  related i-vi

E
external service module interface 3-2

I
installing Cisco SRE service module in router
  basic workflow 2-1
interfaces
  console interface 3-2
  external service module 3-2
  mgf 3-2

L
license key
  accessing 5-4
  accessing from console interface 5-5
  accessing from vSphere Client 5-5
  activating 5-4

M
management network
  link change 6-9
management tools
  Cisco IOS CLI 1-7
  RAID management CLI 1-7
  VMware vSphere Client 1-7
mgf interface 3-2
Microsoft Windows software failure, recovering 8-3

N
NAM support 6-8
non-RAID 4-3

O
OIR 2-3
online insertion and removal 2-3
open source software i-vi

P
prerequisites
  router 3-3
  service module 3-3

R
RAID
  CLI 7-4
  commands 7-4
  hot-swapping 7-3
  management 7-1
  management CLI 7-4
  options 4-1
  raid management command environment 7-1
  raid troubleshooting 7-8
RAID 0 4-3
RAID 1 4-2
RAID CLI, entering 7-1
RAID management
  CLI 1-7
RAID options
  non-RAID 4-3
  RAID 0 4-3
  RAID 1 4-2
raid troubleshooting 7-8
  cannot view datastores 7-8
  rebuild process does not start 7-9
reload 3-24
reset 3-24
resetting system configuration 6-8
RMA 8-1
router and service module compatibility, verifying 2-2

S
  service module
    OIR 2-3
  service module in router, installing 2-2
  service module installation, verifying 2-3
  service request
    submitting i-vi
  shut down 3-24

T
  traffic flow
    Cisco IOS layer 3 routed configuration 3-11
    external interface configuration 3-23
    MGF layer 2 switched configuration 3-4
  transferring licenses 8-1
    from defective device to RMA device 8-1

V
  vCenter
    download 6-4
    managing the service module with 6-4
  virtual machines
    adding in same subnet as hypervisor 6-10
    creating basic workflow 6-5
    limitations 6-5
    networking prerequisites 6-6
  VMkernel
    port value changing 6-9
  VMware
    license key 5-4
  VMware tools, installing 6-6
  VMware vSphere Client 1-7
  VMware vSphere Hypervisor
    advanced customization 6-7
    installing patch 4-12
    installing update release 4-12
    ip address 6-8
    ip address changing 6-9
    license 5-1
    registering license 5-2
    virtual machines in same subnet 6-10
  vSphere client
    downloading 6-1
    installing 6-1
  vSwitches 6-7